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1 Introduction 
1.1 About the User Manual 

This user manual contains an installation description for the netANALYZER 
card NANL-C500-RE and for the netANALYZER device NANL-B500-RE 
under Windows® 2000, Windows® XP, Windows® Vista, Windows® 7 and 
about the operation and hardware for each of these devices. 
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1.1.1 List of Revisions 
Index Date Hard / Software  Chapter Revisions 
1 26 Oct. 

2007 
NANL-C500-RE 
Rev. 3, 
netANALYZER 
Rev. 1.0.0.0 

all created 

2 17.04.08 NANL-C500-RE 
Rev. 3, 
netANALYZER 
Rev. 1.1.0.0 

1.2 
1.3 
3.1 
4 
5.1 
5.2 
5.3 

Section ‚Contents of the Product CD’ actualized, 
Section ‚Reference on Hardware and Software’ actualized, 
Section ‚Analyzer Card NANL-C500-RE’ actualized, 
Section ‚Getting Started and how to use NANL-C500-RE’ 
actualized, 
Section ‚ Data Capturing’ actualized, 
Section ‚Timing Analysis’ added, 
Section ‚Information to Analysis’ revised. 

3 18.06.08 NANL-C500-RE 
Rev. 3, 
netANALYZER 
Rev. 1.1.0.0 

4.7.4 
8 
11 

Section ‚Performing File Settings’ actualized, 
Chapter ‚LED’ actualized, 
Chapter ‚Glossary’ actualized. 

4 09.12.08 netANALYZER 
Rev. 1.2.0.0 

1.3 
4.2.1 
4.3 
4.7 
4.8.2 
4.8.4 
5.1.2.1 

Section ‚Reference on Hardware and Software’ updated, 
Section ‚Notes to the NANL-C500-RE Card Operation’, note added
Section ‚How getting started NANL-C500-RE Card’ added 
Section ‘Installing Wireshark netANALYZER Plugin’ added 
Section ‘netANALYZER – Main Window’ updated  
Section ‘Performing File Settings’ information added  
Section ‚Starting Capturing’ information added  

5 09.02.10 netANALYZER 
Rev. 1.3.0.0 

All, 
 
 
 
 
 
 
 
2, 
5.1, 
5.2, 
5.4,  
5.6,5.7, 
5.9,  
5.10, 
6, 7, 8, 9,
11, 12, 

Revised and completed: 
- completed for Windows 2000/Vista/ 7, 
- added: Device NANL B500-RE, new software, driver and plugin 
versions, 
- added: description new directory structure CD and information on 
the documentation, 
- New features of the user interface of the netANALYZER software: 
Main frame netANALYZER e. g. „Transparent Mode“, 
- chapter ‚Safety’ actualized, 
- section System Requirements: Hints added. 
- section Preconditions for Installation and Operation actualized, 
- sections Starting NANL-C500-RE Card or NANL-B500-RE, 
Installing Software from CD, Installing NANL-C500-RE and NANL-
B500-RE, Wireshark netANALYZER Plugin, netANALYZER 
Software revised, actualized, completed, 
chapters Analysis Methods, Troubleshooting, LED, Technical Data, 
Glossary, Contacts revised, actualized, completed. 

6 08.03.10 netANALYZER 
Rev. 1.3.0.0,  
(NANL-C500-RE 
Rev. 4, NANL-
B500-RE Rev. 1) 

 
1.4, 5.3, 
5.4, 
5.5, 
5.6,  
5.10, 6 

Information to the hardware update added in the sectiontions: 
Reference on Hardware, Driver and Software, Instructions for 
Installation and Operation and Starting NANL-C500-RE Card or 
NANL-B500-RE, Hardware Update (existing Hardware Installation),
Corrections in section/chapter: Installing Software from CD, 
netANALYZER Software, Analysis Methods. 

7 22.03.10 netANALYZER 
Rev. 1.3.0.0,  
(NANL-C500-RE 
Rev. 4, NANL-
B500-RE Rev. 1) 

 
2.8.1, 
5.4, 
5.7.2.1, 
5.7.4, 
 
3, 
 
5.2, 
9.1, 
9.2 

Note device destruction / 24 V power supply added, in the sections:
Device Destruction by exceeding allowed Supply or Signaling 
Voltage, Starting NANL-C500-RE Card or NANL-B500-RE, Device 
Destruction by exceeding allowed Supply or Signaling Voltage, 
Connecting Analyzer Device NANL-B500-RE to the Notebook;  
term for „input/Output“ changed and note added, that only the 
inputs are configured; in chapter Device Drawings and 
Connections; 
Section Preconditions for Installation and Operation completed, 
Section Analyzer Card NANL-C500-RE revised, 
Section Analyzer Device NANL-B500-RE added. 

Table 1: List of Revisions 
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1.2 Legal Notes 

1.2.1 Copyright 
© 2008-2010 Hilscher Gesellschaft für Systemautomation mbH   

All rights reserved. 

The images, photographs and texts in the accompanying material (user 
manual, accompanying texts, documentation, etc.) are protected by 
German and international copyright law as well as international trade and 
protection provisions. You are not authorized to duplicate these in whole or 
in part using technical or mechanical methods (printing, photocopying or 
other methods), to manipulate or transfer using electronic systems without 
prior written consent. You are not permitted to make changes to copyright 
notices, markings, trademarks or ownership declarations. The included 
diagrams do not take the patent situation into account. The company 
names and product descriptions included in this document may be 
trademarks or brands of the respective owners and may be trademarked or 
patented. Any form of further use requires the explicit consent of the 
respective rights owner. 
 

 

1.2.2 Important Notes 
The user manual, accompanying texts and the documentation were created 
for the use of the products by qualified experts, however, errors cannot be 
ruled out. For this reason, no guarantee can be made and neither juristic 
responsibility for erroneous information nor any liability can be assumed. 
Descriptions, accompanying texts and documentation included in the user 
manual do not present a guarantee nor any information about proper use 
as stipulated in the contract or a warranted feature. It cannot be ruled out 
that the user manual, the accompanying texts and the documentation do 
not correspond exactly to the described features, standards or other data of 
the delivered product. No warranty or guarantee regarding the correctness 
or accuracy of the information is assumed.  

We reserve the right to change our products and their specification as well 
as related user manuals, accompanying texts and documentation at all 
times and without advance notice, without obligation to report the change. 
Changes will be included in future manuals and do not constitute any 
obligations. There is no entitlement to revisions of delivered documents. 
The manual delivered with the product applies.  

Hilscher Gesellschaft für Systemautomation mbH is not liable under any 
circumstances for direct, indirect, incidental or follow-on damage or loss of 
earnings resulting from the use of the information contained in this 
publication. 
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1.2.3 Exclusion of Liability 
The software was produced and tested with utmost care by Hilscher 
Gesellschaft für Systemautomation mbH and is made available as is. No 
warranty can be assumed for the performance and flawlessness of the 
software for all usage conditions and cases and for the results produced 
when utilized by the user. Liability for any damages that may result from the 
use of the hardware or software or related documents, is limited to cases of 
intent or grossly negligent violation of significant contractual obligations. 
Indemnity claims for the violation of significant contractual obligations are 
limited to damages that are foreseeable and typical for this type of contract. 

It is strictly prohibited to use the software in the following areas: 

• for military purposes or in weapon systems;  

• for the design, construction, maintenance or operation of nuclear 
facilities; 

• in air traffic control systems, air traffic or air traffic communication 
systems;  

• in life support systems;  

• in systems in which failures in the software could lead to personal injury 
or injuries leading to death. 

We inform you that the software was not developed for use in dangerous 
environments requiring fail-proof control mechanisms. Use of the software 
in such an environment occurs at your own risk. No liability is assumed for 
damages or losses due to unauthorized use. 

 

 

1.2.4 Warranty 
Although the hardware and software was developed with utmost care and 
tested intensively, Hilscher Gesellschaft für Systemautomation mbH does 
not guarantee its suitability for any purpose not confirmed in writing. It 
cannot be guaranteed that the hardware and software will meet your 
requirements, that the use of the software operates without interruption and 
that the software is free of errors. No guarantee is made regarding 
infringements, violations of patents, rights of ownership or the freedom from 
interference by third parties. No additional guarantees or assurances are 
made regarding marketability, freedom of defect of title, integration or 
usability for certain purposes unless they are required in accordance with 
the law and cannot be limited. Warranty claims are limited to the right to 
claim rectification. 
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1.2.5 Export Regulations 
The delivered product (including the technical data) is subject to export or 
import laws as well as the associated regulations of different counters, in 
particular those of Germany and the USA. The software may not be 
exported to countries where this is prohibited by the United States Export 
Administration Act and its additional provisions. You are obligated to 
comply with the regulations at your personal responsibility. We wish to 
inform you that you may require permission from state authorities to export, 
re-export or import the product. 

 

1.2.6 Registered Trademarks 
Windows® 2000, Windows® XP, Windows® Vista, Windows® 7 are 
registered trademarks of the Microsoft Corporation. 
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1.3 Conventions in this Manual 
Operation instructions, a result of an operation step or notes are marked as 
follows: 

Operation Instructions: 
 

 <instruction> 
 

Or 
 

1. <instruction> 

2. <instruction> 
 

Results: 
 

<result> 
 

Notes: 
 

 

Important: <important note> 

 

 
Note:  <note> 

 

 

 <note, were to find further information> 
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1.4 Reference on Hardware, Driver and Software 
 

 
Note: The listed hardware revisions netANALYZER NANL-C500-RE and 
NANL-B500-RE, the driver version for the netANALYZER driver or the 
version of the netANALYZER software functionally belong together.  
For existing hardware installation apply the netANALYZER hardware 
update (for the NXANL 50-RE hardware revisions 2 and 3) and then 
update the driver and the software. 

 

1.4.1 Hardware 
 

Name Card or Device 
Type 

Part No. Hardware
Revision 

Hardware 
Update 

Analyzer Card 
NXANL 50-RE 

NXANL 50-RE 7.310.100 2 Update NXANL 
50-RE Revision 3

Analyzer Card 
NXANL 50-RE 

NXANL 50-RE 7.310.100 3 Update NXANL 
50-RE Revision 3

Analyzer Card 
NANL-C500-RE 

NANL-C500-RE 7.310.100 4 - 

Analyzer Device 
NANL-B500-RE 

NANL-B500-RE 7.311.100 1 - 

Table 2: Reference on Hardware 

 

1.4.2 Software 
 

Software Software Version 
netANALYZER Setup: netAnalyzer.msi 1.3.0.0 

Table 3: Reference on Software 

 

Wireshark netANALYZER Plugin Windows® 2000, 
Windows® XP, 
Windows® Vista, 
Windows® 7 

netanalyzer.dll 32-Bit 

netanalyzer_x64.dll 64-Bit 

Table 4: Reference on Software – Plugin 

 

1.4.3 Driver 
Driver Setup Windows® 2000, 

Windows® XP, 
Windows® Vista, 

Windows® 7 
netANALYZER Driver X86.msi 32-Bit 

netANALYZER Driver X64.msi 64-Bit 

Table 5: Reference on Driver 
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1.5 Contents of the Product CD 
The netANALYZER Installation CD for the netANALYZER card NANL-
C500-RE and for the netANALYZER device NANL-B500-RE contains: 

• The netANALYZER setup file  

• The netANALYZER Driver file for 32-bit and for 64-bit 

• The Wireshark netANALYZER Plugin file for 32-bit and for 64-bit 

• The documentation (netANALYZER User and Driver Manual) 

• 2 Examples for Application Programming Interface (API) 

1.5.1 Directory Structure of the CD 
All manuals on this CD are delivered in the Adobe Acrobat® Reader format 
(PDF).  
 

Directory Name Description 
Adobe Flash Player Adobe Flash Player installation program 

Documentation Documentation in the Acrobat® Reader Format (PDF) 

Driver netANALYZER Driver for Windows® 2000, Windows® XP, 
Windows® Vista, Windows® 7 

Examples 2 Programming examples for the Application Programming 
Interface (API) for the netANALYZER card NANL-C500-RE and for 
the netANALYZER device NANL-B500-RE 

Plugin Wireshark netANALYZER Plugin files: 
netanalyzer.dll, netanalyzer_x64.dll 

Software netANALYZER-Setup: netAnalyzer.msi 
Wireshark netANALYZER Plugin-Setup: WiresharkPlugin.msi 

Update NXANL 50-
RE Revision 3 

netANALYZER hardware update for the hardware-revisions 2  
and 3: netANALYZER_hw_update.iso 

Table 6: Directory Structure of the CD 
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1.5.2 Documentations netANALYZER 
The following documentation overview gives information, for which items 
you can find further information in which manual. 

Manual Contents Document name 
User Manual 
netANALYZER NANL-C500-RE 
and NANL-B500-RE 
Analyzer Card NANL-C500-RE, 
Analyzer Device NANL-B500-RE 
and netANALYZER Software 

Installation, Operation and 
Hardware Description 

netANALYZER_Benutzerhandbuch_de.pdf 

Driver Manual netANALYZER API, 
Windows 2000/XP/Vista/7, V1.3 

Description of the 
netANALYZER API 

netANALYZER API Windows 2000 XP 
Vista 7 DRV 02 EN.pdf 
(English Version) 

Table 7: Documentations netANALYZER 

 

All these documents are available on the CD delivered with the device 
underneath the directory Documentation, in Adobe Acrobat® Reader 
format (PDF). 
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2 Safety 
2.1 General Note 

The user manual, the accompanying texts and the documentation are 
written for the use of the products by educated personnel. When using the 
products, all safety instructions and all valid legal regulations have to be 
obeyed. Technical knowledge is presumed. The user has to assure that all 
legal regulations are obeyed. 

2.2 Intended Use 
The netANALYZER card NANL-C500-RE and the netANALYZER device 
NANL-B500-RE described in this User Manual each work as a passive 
Ethernet Analyzer in RT-Ethernet systems. The netANALYZER card NANL-
C500-RE and the netANALYZER device NANL-B500-RE analyze the data 
in a communication link and capture the incoming Ethernet frames. 

2.3 Personnel Qualification 
The netANALYZER card NANL-C500-RE and the netANALYZER device 
NANL-B500-RE must only be installed, configured and removed by 
qualified personnel. Job-specific technical skills for people professionally 
working with electricity must be present concerning the following topics: 

• Safety and health at work 

• Mounting and connecting of electrical equipment 

• Measurement and Analysis of electrical functions and systems 

• Evaluation of the safety of electrical systems and equipment 

• Installing and Configuring IT systems 
 

2.4 Commitment to read and understand the Manual 
 

 

Important! Read and understand all instructions in this manual before 
installation or use of your device to avoid injury.  

 
 

 

2.5 References Safety 
[1] ANSI Z535.6-2006 American National Standard for Product Safety Information in 

Product Manuals, Instructions, and Other Collateral Materials 
[2] IEC 60950-1, Information technology equipment - Safety -  

Part 1: General requirements, 
(IEC 60950-1:2005, modified); GermanEdition EN 60950-1:2006 

[3] EN 61340-5-1 and EN 61340-5-2 as well as IEC 61340-5-1 and IEC 61340-5-2 
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2.6 Labeling of Safety Instructions 
The safety instructions are pinpointed particularly. The instructions are 
highlighted with a specific safety symbol, a warning triangle and a signal 
word according to the degree of endangerment. Inside the note the danger 
is exactly named. Instructions to a property damage message do not 
contain a warning triangle. 
 

Symbol Symbol 
(USA) 

Sort of Warning or Principle 

 

 Warning of Personal Injury 

  

Warning of Lethal Electrical Shock 

 

 Warning of danger by electrical current 
 

 

 Warning of damages by electrostatic discharge 

 

 Principle: Disconnect the power plug 

 

 Principle: Mandatory read Manual 

Table 8: Safety Symbols and Sort of Warning or Principle 

 

Signal Word Meaning  Signal Word (USA) Meaning (USA) 
DANGER Indicates a direct hazard with high 

risk, which will have as 
consequence death or grievous 
bodily harm if it isn't avoided. 

 
 

Indicates a Hazardous 
Situation Which, if not 
Avoided, will Result in 
Death or Serious Injury. 

WARNING Indicates a possible hazard with 
medium risk, which will have as 
consequence death or (grievous) 
bodily harm if it isn't avoided. 

 
 

Indicates a Hazardous 
Situation Which, if not 
Avoided, could Result in 
Death or Serious Injury. 

CAUTION Indicates a minor hazard with 
medium risk, which could have as 
consequence simple battery if it 
isn't avoided. 

 
 

Indicates a Hazardous 
Situation Which, if not 
Avoided, may Result in 
Minor or Moderate Injury.

NOTICE Indicates a Property Damage 
Message. 

 
 

Indicates a Property 
Damage Message. 

Note Indicates an important note in the 
manual. 

 Note Indicates an Important 
Note in the Manual.  

Table 9: Signal Words 

In this document the safety instructions and property damage messages 
are designed according both to the international used safety conventions as 
well as to the ANSI standard, refer to reference safety [1]. 
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2.7 Safety Instructions 
To ensure your own personal safety and to avoid personal injury, you 
necessarily must read, understand and follow the following and all other 
safety instructions in this guide. 
 

2.7.1 Electrical Shock Hazard 
NANL-C500-RE Card: 
 

 
DANGER! 

 

Lethal Electrical Shock caused by parts with more than 50V! 
 HAZARDOUS VOLTAGE inside of the PC. 
 Therefore first disconnect the power plug of the PC. 
 Make sure, that the power supply is off at the PC. 
 Open the PC cabinet and install or remove the NANL-C500-RE card 
only after disconnecting power. 

 
 

USA: 
 

 

 
 

 
Lethal Electrical Shock caused by parts with more than 50V! 
 HAZARDOUS VOLTAGE inside of the PC. 
 Therefore first disconnect the power plug of the PC. 
 Make sure, that the power supply is off at the PC. 
 Open the PC cabinet and install or remove the NANL-C500-RE card 
only after disconnecting power. 

 

An electrical shock is the result of a current flowing through the human 
body. The resulting effect depends on the intensity and duration of the 
current and on its path through the body. Currents in the range of 
approximately ½ mA can cause effects in persons with good health, and 
indirectly cause injuries resulting from startle responses. Higher currents 
can cause more direct effects, such as burns, muscle spasms, or 
ventricular fibrillation. 

In dry conditions permanent voltages up to approximately 42.4 V peak or 
60 V DC are not considered as dangerous, if the contact area is equivalent 
to a human hand. 

Reference Safety [2] 
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2.8 Property Damage Messages 
To avoid property damage respectively device destruction to the card and 
to your system, you necessarily must read, understand and follow the 
following and all other property damage messages in this guide. 
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2.8.1 Device Destruction by exceeding allowed Supply or Signaling 
Voltage 

The NANL-C500-RE card may not be powered by a 5V power supply! The 
NANL-C500-RE card may only be powered by a 3.3 V power supply. The 
use of a higher supply voltage than 3.3 V may result in severe damage to 
the NANL-C500-RE card! 

The NANL-B500-RE device may only be powered by a power supply in the 
range of 18-30 V. The use of a higher supply voltage than 30 V may result 
in severe damage to the NANL-B500-RE device! 
 

 
NOTICE 

Device Destruction! 
NANL-C500-RE Card: 

 Use only 3.3 V for supply voltage to operate the card.  
Operation with 5 V supply voltage leads to device destruction. 

NANL-B500-RE Device: 

 The voltage applied at the NANL-B500-RE device must not exceed 
30 V, otherwise the device may be destroyed. 

 Connect only one 24 V DC power supply to the device. If the device is 
connected to both power connectors (0V/+24V/PE and +24V) simulta-
neously, this may lead to damage to the used power supply units! 

NANL-C500-RE Card and NANL-B500-RE Device: 

 All I/O signal pins at the NANL-C500-RE card and at the NANL-B500-
RE tolerate only 3.3 V signaling voltage! 

 Operation with 5 V signaling voltage may lead to severe damage to the 
NANL-C500-RE card or to the NANL-B500-RE device! 

 
 

USA: 
 

 
 

 
Device Destruction! 
NANL-C500-RE Card: 

 Use only 3.3 V for supply voltage to operate the card.  
Operation with 5 V supply voltage leads to device destruction. 

NANL-B500-RE Device: 

 The voltage applied at the NANL-B500-RE device must not exceed 
30 V, otherwise the device may be destroyed. 

 Connect only one 24 V DC power supply to the device. If the device is 
connected to both power connectors (0V/+24V/PE and +24V) simulta-
neously, this may lead to damage to the used power supply units! 

NANL-C500-RE Card and NANL-B500-RE Device: 

 All I/O signal pins at the NANL-C500-RE card and at the NANL-B500-
RE tolerate only 3.3 V signaling voltage! 

 Operation with 5 V signaling voltage may lead to severe damage to the 
NANL-C500-RE card or to the NANL-B500-RE device! 
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2.8.2 Electrostatically sensitive Devices 
NANL-C500-RE-Karte:  

Adhere to the necessary safety precautions for components that are 
vulnerable with electrostatic discharge. 
 

 
NOTICE 

Electrostatically sensitive Devices 
This equipment is sensitive to electrostatic discharge, which cause 
internal damage and affect normal operation. Follow guidelines when you 
handle this equipment: 

 Touch a grounded object to discharge potential static. 

 Wear an approved grounding wriststrap. 

 Do not touch connectors or pins on component boards. 

 Do not touch circuit components inside the equipment. 

 If available, use a static-safe workstation. 

 When not in use, store the equipment in appropriate static-safe 
packaging. 

 

 

USA: 
 

 
 

 
Electrostatically sensitive Devices 
This equipment is sensitive to electrostatic discharge, which cause 
internal damage and affect normal operation. Follow guidelines when you 
handle this equipment: 

 Touch a grounded object to discharge potential static. 

 Wear an approved grounding wriststrap. 

 Do not touch connectors or pins on component boards. 

 Do not touch circuit components inside the equipment. 

 If available, use a static-safe workstation. 

 When not in use, store the equipment in appropriate static-safe 
packaging. 

 

Reference Safety [2] 
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3 Device Drawings and Connections 
3.1 Device Drawing NANL-B500-RE 

 

 

 
SYS 
System LED 
(yellow/green) 
STA 0, STA1 
Status LED 
(red/green) 

External Interface  
Input/Output Signals 
(4 digital Inputs/Outputs) 

 
RJ45 Sockets 
4 Ports: Port 0 to Port 3, 
2 Communication Channels: 
TAP B, TAP A) 

Note: To analyze the data transfer of a communication line between two devices, these 
devices must be connected to the same TAP (Test Application Point). 

Note: The 4 digital inputs / outputs of the external interface input / output signals are 
configured by the software only as inputs. 

Figure 1: Device Drawing NANL-B500-RE (Front Side) 

The meaning of the yellow and green LED at the RJ45 socket depends 
from the loaded firmware. See chapter LED on page 103. 
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Micro SD Card Slot* Mini B USB Plug* 

(5-pin) 
 

24V Voltage Supply 

 
Switch*  
(RUN / STOP / RESET) 

Cable to ExpressCard 
 

Combicon: 0V/+24V/PE 

 * for future use only   
 

alternatively  
Female Connector +24V 

Figure 2: Device Drawing NANL-B500-RE (Reverse Side) 
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ExpressCard netANALYZER Device  

NANL-B500-RE  
Cable 

Figure 3: Device Drawing NANL-B500-RE (with ExpressCard) 
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3.2 Device Drawing NANL-C500-RE 

Note: To analyze the data transfer of a communication line between two devices, these devices must 
be connected to the same TAP (Test Application Point). 

Note: The 4 digital inputs / outputs of the external interface input / output signals are configured by 
the software only as inputs. 

Figure 4: Device Drawing NANL-C500-RE 

The meaning of the yellow and green LED at the RJ45 socket depends 
from the loaded firmware. See chapter LED on page 103. 
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Figure 5: Slot PlateNANL-C500-RE 
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3.3 Ethernet Interface 
For the Ethernet interface use RJ45 plugs and twisted pair cable of 
category 5 (CAT5) or higher, which consists of 4 twisted cores and has a 
maximum transmission rate of 100 MBit/s (CAT5).  

3.3.1 Ethernet pinning at the RJ45 Socket 

 
Figure 6: Ethernet pinning at the RJ45 Socket 

Pin Signal Meaning 
1 TX+ Transmit Data + 
2 TX– Transmit Data – 
3 RX+ Receive Data + 
4 Term 1 
5 Term 1 

Connected to each other and 
terminated to PE through RC circuit* 

6 RX– Receive Data – 
7 Term 2 
8 Term 2 

Connected to each other and 
terminated to PE through RC circuit* 

  * Bob Smith Termination 

Table 10: Ethernet pinning at the RJ45 Socket 

 

3.3.2 Data of the Ethernet Connection  
Medium 2 x 2 Twisted-Pair cupric cable, CAT5 (100 MBit/s) 
Length of cable max. 100 m 
Reception Rate 10 MBit/s / 100 MBit/s 

Table 11: Data of the Ethernet Connection  
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3.4 External Interface Input/Output Signals 

 
NOTICE! 

Device Destruction! 
 All I/O signal pins at the NANL-C500-RE card and at the NANL-B500-
RE tolerate only 3.3 V signaling voltage! 

 Operation with 5 V signaling voltage may lead to severe damage to the 
NANL-C500-RE card or to the NANL-B500-RE device! 

 

USA: 
 

 
 

 
Device Destruction! 
 All I/O signal pins at the NANL-C500-RE card and at the NANL-B500-
RE tolerate only 3.3 V signaling voltage! 

 Operation with 5 V signaling voltage may lead to severe damage to the 
NANL-C500-RE card or to the NANL-B500-RE device! 

 

 
Note: The 4 digital inputs / outputs of the external interface input / output 
signals are configured by the software only as inputs. 

 

Connector external Interface Input/Output Signals / (4 digital 
inputs/outputs): 

 
Figure 7: Connector external Interface Input/Output Signals, X40 

 

Pin Signal  Pin Signal 
2 GND  1 3 

4 GND  3 2 

6 GND  5 1 

8 GND  7 0 

Table 12: Pin out, X40 

3.4.1 Connection Cable for Input Signals 
To access to the digital input signals (GPIO), use a cable, which does not 
exceed the following parameters / values. 
Parameter Value 
Min. conductor cross section 0,2 mm2 

Max. conductor cross section 1 mm2 

Max. cable length 5 m 

Shielding Shielded cables 

Table 13: Connection Cable for Input Signals 
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4 Description and Requirements 
4.1 NANL-C500-RE and NANL-B500-RE 

The netANALYZER card NANL-C500-RE and the netANALYZER device 
NANL-B500-RE work as a passive component in Real-Time Ethernet 
systems to record and analyze the data traffic. 

By use of the netANALYZER software netANALYZER the modes listed 
hereafter can be used: 

Data-Capturing Mode 
In the data-capturing mode (Capture Data), the data are recorded to the 
hard disk of the PC.  

For further information refer to section Recording and analyzing Data 
Traffic beginning from page 28. 

For data capturing two operating modes are provides: 

• Ethernet Mode (Standard Capturing) 
In the Ethernet Mode standard Ethernet telegrams are captured. 

• Transparent Mode 
In the Transparent Mode standard Ethernet telegrams are captured, which 
include the preamble and the SFD (=Start of Frame Delimiter). 

For further information refer to section Transparent Mode beginning from 
page 101. 
 

Timing Analysis Mode 
In the timing analysis mode (Timing Analysis), no frame data are stored, 
only the time stamp of individual frames are analyzed. Any data recording 
is performed. 

For further information refer to section Timing Analysis beginning from 
page 91. 
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4.1.1 Recording and analyzing Data Traffic 
For devices with two Ethernet channels the netANALYZER card NANL-
C500-RE or the netANALYZER device NANL-B500-RE capture the 
Ethernet frames and adds the time stamps to them. Therefore the 
netANALYZER card NANL-C500-RE or the netANALYZER device NANL-
B500-RE must be connected over two patch cables from one of the TAP to 
the Ethernet device connections. 

 

Device 1 Device 2 Device 3

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet

Ethernet

Ethernet

Ethernet

Ethernet

Ethernet

 
Figure 8: Typical Application (Use Case 2) - The communication between a device and its 
connection partners in a network should be analyzed 

The data capturing must be configured and started via the netANALYZER 
software. 

This way the netANALYZER card NANL-C500-RE or the netANALYZER 
device NANL-B500-RE and the netANALYZER software capture the data 
packets of the communication line, transmit the data packets and safe them 
on the hard disk. 
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On the netANALYZER card NANL-C500-RE or at the netANALYZER 
device NANL-B500-RE two TAP (Test Access Point) are integrated so that 
two communication channels are operational. 

Ethernet
-Device A

RJ45
Port0

RJ45
Port1

TAP

1/2 3/6 1/2 3/6

to Analyzer

B/A A/B

RJ45
Port

1/2 3/6

Ethernet
-Device B

RJ45
Port

1/2 3/6

 
Figure 9: Example representation physical TAP 

In combination with the driver and the firmware the netANALYZER card 
NANL-C500-RE or the netANALYZER device NANL-B500-RE store the 
data via DMA on the hard disk of the PC. There the netANALYZER 
software then converts the stored binary files (*.hea) in the open WinPcap 
format (*.pcap), which can be analyzed e. g. with Wireshark. 

NANL-C500-RE
PCI Card

or NANL-B500-RE
with ExpressCard,

with integrated TAPs
and IO Event CaptureEthernet

Ethernet
Device(s) with
digital Outputs

4x IO Lines

Ethernet

Hard Disk Drive

Analysis with
Wireshark

 
Figure 10: Typical Analyzer Application with the Capturing of the Ethernet Data Transfer and 
IO Events 
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Additionally, events of up to four digital inputs can be captured. At the four 
digital inputs the input signals produce a special Ethernet frame in the 
netANALYZER card NANL-C500-RE or the netANALYZER device NANL-
B500-RE. This frame is not on the line, but is created for evaluation 
purposes. 
 

 
Note: For the GPIO events in Wireshark a pseudo Ethernet frame is 
shown (MAC Address 00:02: A2: FF: FF: FF, Ether Type = 0x88ff), this is 
not a true Ethernet frame, but is inserted as wildcard in the firmware. Then 
this frame is decoded as GPIO event e. g. with Wireshark. 
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5 Start and use NANL-C500-RE or NANL-B500-RE 
To start and use the netANALYZER card NANL-C500-RE or the 
netANALYZER device NANL-B500-RE refer to the following sections. 

 

5.1 System Requirements and Accessories 

System Requirements: 
1. Operating System: 

• Windows® 2000, SP4, (32-bit Version), 

• Windows® XP Professional, SP3, (32-bit and 64-bit Version), 

• Windows® Vista, (32-bit and 64-bit Version), 

• Windows® 7, (32-bit and 64-bit Version). 

2. PC with the following specification: 

• Intel compatible CPU, approx. 2 GHz or faster, 

• 1 GB RAM or more, 

• CD or DVDROM, 

• SVGA 1024x768 16bit colors or better, 

• 20 MB free hard drive space for die netANALYZER software, 

• Free hard drive space for data capturing (minimum 1GB). 
 

Type of Card PCI Connector 
NANL-C500-RE  PCI slot (3.3 V) 

NANL-B500-RE  ExpressCard Slot 
(for notebook) 

Table 14: PCI Connector for NANL-C500-RE cards or NANL-B500-RE 

Accessories: 
1. Two patch cable (Ethernet) 

2. The maximum allowed cable length for the  24V power supply is 
3 meters. 

 

 
Note: The maximum allowed total length of the Ethernet cable via which 
the netANALYZER card NANL-C500-RE or the netANALYZER device 
NANL-B500-RE within the Ethernet system are connected via a TAP to 
the devices in the system is 100 meters. 

 

 



Start and use NANL-C500-RE or NANL-B500-RE 32/111 

netANALYZER NANL-C500-RE and NANL-B500-RE | Installation, Operation and Hardware Description  
DOC091110UM07EN | Revision 7 | English | 2010-03 | Released | Public  © Hilscher, 2007-2010 

5.2 Preconditions for Installation and Operation 
For operation of the netANALYZER card NANL-C500-RE or the 
netANALYZER device NANL-B500-RE and of the netANALYZER software 
the following in preconditions must be fulfilled: 

Preconditions for Installation: 
1. The program Microsoft .NET Framework Version 2.0* must be installed. 

2. For the installation under Windows® 2000 the Windows Installer 3.1* 
must be installed.  

 

Preconditions for Operation: 

1. To display the captured data, a network monitoring program must be 
installed, which supports the WinPcap format, as e. g. Wireshark*. 

2. The netANALYZER software V 1.3.0.0 must be installed. This includes 
the netANALYZER software, the Analyzer driver and the Analyzer 
firmware “Ethernet-Analyzer”. 

*For further information to the mentioned programs refer to the Glossary on 
page 109. 
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5.3 Instructions for Installation and Operation 
You must read and obey the following instructions for installation and 
operation of your netANALYZER card NANL-C500-RE or your 
netANALYZER device NANL-B500-RE to garantee proper installation and 
an error-free operation of your device. 
 

Note 

 

Description 

Updates for existing 
Hardware Installation 

For existing hardware installation apply the netANALYZER hardware update (for 
the NXANL 50-RE hardware revisions 2 and 3) and then update the driver and 
the software. For more information refer to section Hardware Update (existing 
Hardware Installation) on page 35. 

Note the Installation 
Sequence 

The installation sequence: 
1. Insert CD 
2. Install software 
3. Mount NANL-C500-RE or connect NANL-B500-RE 
must be obeyed. Otherwise, there will be incorrect registry entries. This in turn 
leads to disturbances in subsequent installation of software updates. 

Installing Wireshark 
netANALYZER Plugin 
manually 

The Wireshark netANALYZER plugin must be installed to allow displaying the 
netANALYZER port number and error codes for every telegram in Wireshark.
  
The plugin is only installed during the installation of the netANALYZER software 
from CD, if Wireshark is installed already on the PC, otherwise the plugin must 
be installed manually.   
Before installing the current plugin, the manually installed plugin of the 
netANALYZER versions 1.0-1.2 must be deinstalled. Also the 64-bit and the 32-
bit Wireshark netANALYZER plugin are not compatible. Each of them must be 
deinstalled before the other plugin can be installed. For more information refer to 
section Wireshark netANALYZER Plugin on page 67. 

Optimum Operation if 
view Participants at PCI 
or PCI Express Bus 

The capturing feature of the NANL-C500-RE card or the NANL-B500-RE device 
works under heavy load optimally only if the number of participants in the 
communications PCI bus or PCI Express bus is minimized. It is advantageous if 
the NANL-C500-RE card is the only PCI card in the PC or if the NANL-B500-RE 
device is the only ExpressCard at the notebook. 

Inserting Analyzer Card 
into the Communication 
Link 

To analyze the data transfer of a communication line between two devices, these 
devices must be connected to the same TAP (Test Access Port). 

Activating Wireshark 
GPIO Dissector 

GPIO events of the NANL-C500-RE card or of the NANL-B500-RE device card 
are decoded by Wireshark beginning with version 1.0.0. If after Wireshark 
installation the "Hilscher-netANALYZER-GPIO event" is not displayed, the 
appropriate protocol must be activated in Wireshark once. For more information 
refer to section Activating Wireshark GPIO Dissector on page 64. 

Do not unplug the 
ExpressCard during the 
Device Operation 

During device operation do not unplug the ExpressCard of the netANALYZER 
device NANL-B500-RE from the ExpressCard slot at the Notebook. Otherwiese 
data capturing is stopped and an error message is displayed, as the device is not 
any more detected at the notebook. 

Table 15: Instructions for Installation and Operation 
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5.4 Starting NANL-C500-RE Card or NANL-B500-RE 
The following table provides an overview of the steps how to start the 
netANALYZER card NANL-C500-RE or the netANALYZER device NANL-
B500-RE. 
 

No Step Short Description For detailed information 
see section 

Page 

Preconditions 

1 Preconditions for 
Operation and 
Instructions for 
Installation and 
Operation 

Read the Preconditions for Operation and the 
Instructions for Installation and Operation. 

Preconditions for Installation 
and Operation, 
Instructions for Installation 
and Operation 

32, 
33 

Installation 

1 Hardware Update  
(for existing hardware 
installation) 

For existing hardware installation (for the 
NXANL 50-RE hardware revisions 2 and 3) 
apply the netANALYZER hardware update. 

Hardware Update (existing 
Hardware Installation)  

35 

2 Installing software from 
CD 

Install the setup for the netANALYZER 
software from CD. 
1. Insert CD 
2. Install software 

Installing Software from CD 37 

3 3. Mount NANL-C500-RE card   
 

Mounting the 
netANALYZER card into 
the PC 

Read the corresponding safety instructions. Safety Instructions 54 

  Mount the netANALYZER card NANL-C500-RE 
into the PC. 

Mounting Analyzer Card 
NANL-C500-RE to the PC 

57 

 Or Or   
 Connect the 

netANALYZER device to 
the notebook. 

3. Connect the NANL-B500-RE device 
Connect the netANALYZER device NANL-
B500-RE d to the notebook. 
Important: Connect only one 24 V DC power 
supply to the device. 

Connecting Analyzer Device 
NANL-B500-RE to the 
Notebook 

58 

4 Inserting analyzer card 
or device in the 
communication link 

Insert the NANL-C500-RE card or the NANL-
B500-RE device into the communication link to 
be analyzed. 

Inserting Analyzer Card into 
the Communication Link 

59 

5 Activating Wireshark 
GPIO Dissector 

4. Activating Wireshark GPIO Dissector Activating Wireshark GPIO 
Dissector 

64 

6 Performing File Settings Set file name and capturing path for the 
capturing process. 

Performing File Settings 79 

Data Capturing 
1 Starting Data Capturing Start the capturing process of the received 

Ethernet frames.  
Starting Data Capturing 87 

2 Converting binary Files 
into WinPcap Format  

Convert binary files *.hea into WinPcap format 
*.pcap. 

Converting Binary Files into 
WinPcap Format 

88 

3 Displaying Analysis Data Display analysis data of the Ethernet Frames 
using e. g. Wirkeshark 

See help of the used 
network monitoring 
program. 

- 

Timing Analysis 
1 Presettings Enter title, select port, configure axis and 

histogram settings 
Timing Analysis 91 

2 Data Evaluation Measuring value and histogram evaluation Timing Analysis 91 

Table 16: Getting started NANL-C500-RE Card or NANL-B500-RE 
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5.5 Hardware Update (existing Hardware Installation) 
For existing hardware installation for the NXANL 50-RE hardware revisions 
2 and 3 you must apply the netANALYZER hardware update and then 
update the driver and the software. 

Therefore proceed as described below:  

1. Burn an ISO image of the netANALYZER Hardware Update on a CD. 

 Burn the file Update NXANL 50-RE Revision 3\netANALYZER_ 
hw_update.iso from the netANALYZER installation CD (product CD) as 
ISO image on a CD.  

2. Boot the PC with the existing hardware installation. 

3. Put the CD with the ISO image of the netANALYZER hardware update 
into the CD-ROM drive of this PC. 

 The system of the PC boots and after a short time the following text is 
displayed at the screen: 

 

 

4. Start the Hardware Update. 

 Therefore enter netanalyzer-updater. 
 

 

 Press Enter. 
 The hardware update utiltiy searchs for Hilscher devices and then for 

netANALYZER devices. 
 

 

------------------------------------------------------------------------------ 

This is an update CD for netANALYZER Rev 2 an Rev 3 card which do not work 

under Windows Vista and Windows 7. 

This happens due to an invalid subvendor ID provided by the cards on the PCI 

bus. Please call "netanalyzer-update" to start the update procedure. 

------------------------------------------------------------------------------ 

user@netANALYZER-update: ~$ 
 

 

user@netANALYZER-update: ~$netanalyzer-updater 
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 The following text is displayed at the screen: 
 

 

5. Continue the Hardware Update. 

 Therefore enter y. 
 

 

 Press Enter. 
 The following text is displayed at the screen: 

 

 

6. Reboot the PC with the existing hardware installation. 

 The hardware update is finished.  

7. Now actualize the netANALYZER driver and the netANALYZER 
software, as described under section How to install the Software from 
page 38 on. 

 

 

 

Initializing drivers: Done 

Search Hilscher Devices: Done 

Found Hilscher Devices 

------------------------------------------------------------------------------ 

Bus| Dev |Func | Phys Addr. | Vendor | Device | SubVendor | SubDevice | DevClass 

[Werte der Liste der Geräte] 

------------------------------------------------------------------------------ 

Do you want to continue with the update? (y/n) 

 

Please reboot your computer now, to activate the changes! 

user@netANALYZER-update: ~$ 

 

Do you want to continue with the update? (y/n)y 
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5.6 Installing Software from CD 

5.6.1 Components and Options 
The Software installation includes the following components:  

• netANALYZER Software netANALYZER 

• netANALYZER Driver 

• Wireshark netANALYZER Plugin 

• Documentation 

• Examples 

 

The software installation from CD contains the following possibilities:  

(1.) Full Install 

Installs the netANALYZER software, the netANALYZER Driver and the 
Wireshark Plugin. 

(2.) netANALYZER Software Install  

Installs only the netANALYZER software. 

(3.) netANALYZER Driver Install 

Installs only the netANALYZER Driver. 

(4.) Wireshark Plugin Install 

Installs only the Wireshark Plugin. 
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5.6.2 How to install the Software 
 

 

Important! Before installing the software any existing old versions of the 
netANALYZER software and the netANALYZER driver must be 
uninstalled. 

 

To install the software proceed as described hereafter: 

1. Close all programs! 

2. Enter the netANALYZER Installation CD in the local CD ROM drive. 

 The start screen of the autostart menu is displayed with the following 
options: 

 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 
     Install netANALYZER Software only 
     Install netANALYZER Driver only 
     Install Wireshark Plugin only 
  Documentation 

  Examples 
 
 

Figure 11: Options Autostart Menu of the netANALYZER Installation CD: Options 
netANALYZER Software 

 

3. Select netANALYZER of the autostart menu. 
 

 
Note: Under Windows® XP you need administration rights for the 
installation! 

 

4. Select scope of installation: 

The autostart menu offers four installation options: 

(1.) Full Install 

(2.) Install netANALYZER Software only 

(3.) Install netANALYZER Driver only 

(4.) Install Wireshark netANALYZER Plugin only 

5. Follow to the instructions at the screen.  
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(1.) Full Install 
 Select Full Install: netANALYZER Software, Driver and Wireshark 

Plugin, if the full scope of installation is required. 

 The following installations are started now sequentially: 

• netANALYZER Software netANALYZER 

• netANALYZER Driver 

• Wireshark netANALYZER Plugin 

 Follow to the instructions at the screen.  

 

(2.) Install netANALYZER Software only 
 Select Install netANALYZER Software only, if only the netANALYZER 

Software installation is required. 

 The following installation is started: 

• netANALYZER Software netANALYZER. 
 Follow to the instructions at the screen.  

 
 

(3.) Install netANALYZER Driver only 
 Select Install netANALYZER Driver only, if only the netANALYZER 

Driver installation is required. 

 The following installation is started: 

• netANALYZER Driver. 

 Follow to the instructions at the screen.  

 

(4.) Install Wireshark netANALYZER Plugin only 
 Select Install Wireshark Plugin only, if only the Wireshark 

netANALYZER Plugin installation is required. 

 The following installation is started: 

• Wireshark netANALYZER Plugin 

 Follow to the instructions at the screen.  
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5.6.2.1 Installation netANALYZER Software 

This section describes the installation procedure of the netANALYZER 
Software, if the following options are selected in the autostart menu: 

• Full Install: netANALYZER Software, Driver and Wireshark Plugin 
 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 
     Install netANALYZER Software only 

     Install netANALYZER Driver only 

     Install Wireshark Plugin only 

  Documentation 

  Examples 
 
 

Figure 12: Options Autostart Menu of the netANALYZER Installation CD: Installation of the 
netANALYZER Software via „Full Install“ 

or  

• Install netANALYZER Software only 
 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 

     Install netANALYZER Software only 
     Install netANALYZER Driver only 

     Install Wireshark Plugin only 

  Documentation 

  Examples 
 
 

Figure 13: Options Autostart Menu of the netANALYZER Installation CD: Installation of the 
netANALYZER Software via „Install netANALYZER Software only“ 

 The installation is started: 
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Figure 14: netANALYZER Setup Wizard: Start Screen 

 The screen Welcome to the netANALYZER Setup Wizard is 
displayed:  

 
Figure 15: netANALYZER Setup Wizard: The Installer guides you through the Setup.  

 Click to Next. 
 The screen License Agreement is displayed:  
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Figure 16: netANALYZER Setup Wizard: Hilscher Software License Agreement 

 Click to I Agree.  

 The screen Select Installation Folder is displayed:  

 
Figure 17: netANALYZER Setup Wizard: Defining the Installation Directory and the User 

 Under Folder define the installation folder. 

 Possibly select via Browser… a different directory. 
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 Possibly check via Disk Cost… the free disk space.  

 Define the user: Everyone or Just me. 

 The screen Confirm Installation is displayed:  

 
Figure 18: netANALYZER Setup Wizard: Starting the netANALYZER Installation 

 Start the netANALYZER installation via Next.  
 The screen Installing netANALYZER is displayed:  

 
Figure 19: netANALYZER Setup Wizard: netANALYZER Installation  
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 The screen Installation complete is displayed:  

 
Figure 20: netANALYZER Setup Wizard: Closing the netANALYZER Installation 

 Close the netANALYZER installation via Close.  

 The netANALYZER installation is complete.  

For the selection Full Install now will follow:  

• the netANALYZER Driver Setup Wizard and  

• the netANALYZER Wireshark Setup Wizard. 
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5.6.2.2 Installation netANALYZER Driver 

This section describes the installation procedure of the netANALYZER 
Driver, if the following options are selected in the autostart menu: 

• Full Install: netANALYZER Software, Driver and Wireshark Plugin 
 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 
     Install netANALYZER Software only 

     Install netANALYZER Driver only 

     Install Wireshark Plugin only 

  Documentation 

  Examples 
 
 

Figure 21: Options Autostart Menu of the netANALYZER Installation CD: Installation of the 
netANALYZER Driver via „Full Install“ 

or  

• Install netANALYZER Driver only 
 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 

     Install netANALYZER Software only 

     Install netANALYZER Driver only 
     Install Wireshark Plugin only 

  Documentation 

  Examples 
 
 

Figure 22: Options Autostart Menu of the netANALYZER Installation CD: Installation of the 
netANALYZER Driver via „Install netANALYZER Driver only“ 

 

 The installation is started: 

For the selection Full Install first will follow:  

• the netANALYZER Setup Wizard. 

 Then screen Please read the netANALYZER Device Driver License 
Agreement is displayed: 
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Figure 23: netANALYZER Device Driver Setup Wizard (Example (x86) 1.3.4.0): Hilscher 
Software License Agreement 

 Check I accept the terms in the License Agreement. 
 Start the netANALYZER Driver Installation via Install. 
 The screen Installing netANALYZER Device Driver is displayed: 

 
Figure 24: netANALYZER Device Driver Setup Wizard (Example (x86) 1.3.4.0): 
netANALYZER Driver Installation 

 The screen Completed the netANALYZER Device Driver Setup 
Wizard is displayed:  
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Figure 25: netANALYZER Device Driver Setup Wizard (Example (x86) 1.3.4.0): Finishing the 
netANALYZER Driver Installation 

 Finish the netANALYZER Driver Installation via Finish. 

 The netANALYZER Driver Installation is complete. 

For the selection Full Install now will follow: 

• the netANALYZER Wireshark Setup Wizard. 
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5.6.2.3 Hints on how to install the netANALYZER Driver manually 

The netANALYZER Device Driver can be installed manually.  

Via EXE File (recommended): 
By use of the setup file „netANALYZER Driver Setup.exe“ the bit version 
(„x86“ = 32-bit or „x64“ = 64-bit) is selected automatically. 

 To install the netANALYZER Driver manually, double click in the 
„Driver“ of the netANALYZER Installation CD to the file „netANALYZER 
Driver Setup.exe“. 

 
Figure 26: netANALYZER Driver Installation manually 

 Follow to the instructions at the screen.  

Via MSI File: 
 

Note: If for the netANALYZER Driver Installation the netANALYZER 
Driver x[bit version].msi file is activated via double click and the bit version 
(„x86“ = 32-bit, „x64“ = 64-bit) of the activated file is incompatible to the 
system requirements, the Windows Installer error message is displayed, 
that the installation package is not supported by this processor type. 

 

 
Figure 27: netANALYZER Driver manual Installation Error Message 

 To install the netANALYZER Driver correctly, select the bit version of 
the netANALYZER Driver x[bit version].msi file, which is compatible to 
the system requirements. 
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5.6.2.4 Installation Wireshark netANALYZER Plugin 

This section describes the installation procedure of the netANALYZER 
Wireshark Plugin, if the following options are selected in the autostart 
menu: 

• Full Install: netANALYZER Software, Driver and Wireshark Plugin 
 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 
     Install netANALYZER Software only 

     Install netANALYZER Driver only 

     Install Wireshark Plugin only 

  Documentation 

  Examples 
 
 

Figure 28: Options Autostart Menu of the netANALYZER Installation CD: Installation of the 
netANALYZER Wireshark Plugin via „Full Install“ 

or  

• Install Wireshark Plugin only 
 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 

     Install netANALYZER Software only 

     Install netANALYZER Driver only 

     Install Wireshark Plugin only 

  Documentation 

  Examples 
 
 

Figure 29: Options Autostart Menu of the netANALYZER Installation CD: Installation of the 
netANALYZER Wireshark Plugin via „Install Wireshark Plugin only“ 

 

 The installation is started: 

For the selection Full Install first will follow:  

• the netANALYZER Setup Wizard and 

• the netANALYZER Driver Setup Wizard. 

 Then screen Welcome to the netANALYZER Driver Setup Wizard is 
displayed:  
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Figure 30: netANALYZER Wireshark Plugin Setup Wizard: The Installer guides you through 
the Setup. 

 Click to Next. 
 The screen Select Installation Folder is displayed:  

 
Figure 31: netANALYZER Wireshark Plugin Setup Wizard: Defining the Installation Directory 
and the User 

 Under Folder define the installation folder. 

 Possibly select via Browser… a different directory. 
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 Possibly check via Disk Cost… the free disk space.  

 Define the user: Everyone or Just me. 

 The screen Confirm Installation is displayed:  

 
Figure 32: netANALYZER Wireshark Plugin Setup Wizard: Starting the netANALYZER 
Wireshark Plugin Installation 

 Start the netANALYZER Wireshark Plugin Installation via Next.  
 The screen Installing netANALYZER is displayed:  
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Figure 33: netANALYZER Wireshark Plugin Setup Wizard: netANALYZER Wireshark Plugin 
Installation 

 The screen Installation complete is displayed:  

 
Figure 34: netANALYZER Wireshark Plugin Setup Wizard: Close the netANALYZER 
Wireshark Plugin Installation 

 Close the netANALYZER Wireshark Plugin Installation via Close.  

 The netANALYZER Wireshark Plugin Installation is complete.  
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5.6.3 Open Documentation or Examples 
Via the autostart menu of the netANALYZER Installation CD are also 
available: 

• The documentation for the netANALYZER card NANL-C500-RE and 
the netANALYZER device NANL-B500-RE 

• 2 programming examples for the application programming interface 
(API) the netANALYZER card NANL-C500-RE and the netANALYZER 
device NANL-B500-RE 

Therefore: 

1. Close all programs! 

2. Enter the netANALYZER Installation CD in the local CD ROM drive. 

 The start screen of the autostart menu is displayed with the following 
options: 

 
 

  netANALYZER 

     Full Install: netANALYZER Software, Driver and Wireshark Plugin 

     Install netANALYZER Software only 

     Install netANALYZER Driver only 

     Install Wireshark Plugin only 

  Documentation 
  Examples 
 
 

Figure 35: Options Autostart Menu of the netANALYZER Installation CD: Documentation or 
Programming Examples 

 

3. Documentation: 

 Click to Documentation. 

 The folder Documentation is displayed with: 

• The user manual netANALYZER NANL-C500-RE and NANL-B500-
RE, Analyzer Card NANL-C500-RE, Analyzer Device NANL-B500-
RE and netANALYZER Software 

• The folder API with the Driver Manual netANALYZER API, Windows 
2000/XP/Vista/7, V1.3 

Refer also to section Documentations netANALYZER on page 13.  

4. Programming Examples: 

 Click to Examples. 

 The folder Examples is displayed with:  

 2 programming examples for the application programming interface 
(API) the netANALYZER card NANL-C500-RE and the netANALYZER 
device NANL-B500-RE 
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5.7 Installing NANL-C500-RE and NANL-B500-RE 

5.7.1 Safety Instructions 
Obey to the following safety advices, when installing the NANL-C500-RE 
card. 

5.7.1.1 Electrical Shock Hazard 

NANL-C500-RE Card: 
 

 
DANGER! 

 

Lethal Electrical Shock caused by parts with more than 50V! 
 HAZARDOUS VOLTAGE inside of the PC. 
 Therefore first disconnect the power plug of the PC. 
 Make sure, that the power supply is off at the PC. 
 Open the PC cabinet and install or remove the NANL-C500-RE card 
only after disconnecting power. 

 
 

USA: 
 

 

 
 

 
Lethal Electrical Shock caused by parts with more than 50V! 
 HAZARDOUS VOLTAGE inside of the PC. 
 Therefore first disconnect the power plug of the PC. 
 Make sure, that the power supply is off at the PC. 
 Open the PC cabinet and install or remove the NANL-C500-RE card 
only after disconnecting power. 
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5.7.2 Property Damage Messages 
Obey to the following property damage messages, when installing the 
netANALYZER card NANL-C500-RE and the netANALYZER device NANL-
B500-RE. 

5.7.2.1 Device Destruction by exceeding allowed Supply or Signaling Voltage 
 

 
NOTICE 

Device Destruction! 
NANL-C500-RE Card: 

 Use only 3.3 V for supply voltage to operate the card.  
Operation with 5 V supply voltage leads to device destruction. 

NANL-B500-RE Device: 

 The voltage applied at the NANL-B500-RE device must not exceed 
30 V, otherwise the device may be destroyed. 

 Connect only one 24 V DC power supply to the device. If the device is 
connected to both power connectors (0V/+24V/PE and +24V) simulta-
neously, this may lead to damage to the used power supply units! 

NANL-C500-RE Card and NANL-B500-RE Device: 

 All I/O signal pins at the NANL-C500-RE card and at the NANL-B500-
RE tolerate only 3.3 V signaling voltage! 

 Operation with 5 V signaling voltage may lead to severe damage to the 
NANL-C500-RE card or to the NANL-B500-RE device! 

 
 

USA: 
 

 
 

 
Device Destruction! 
NANL-C500-RE Card: 

 Use only 3.3 V for supply voltage to operate the card.  
Operation with 5 V supply voltage leads to device destruction. 

NANL-B500-RE Device: 

 The voltage applied at the NANL-B500-RE device must not exceed 
30 V, otherwise the device may be destroyed. 

 Connect only one 24 V DC power supply to the device. If the device is 
connected to both power connectors (0V/+24V/PE and +24V) simulta-
neously, this may lead to damage to the used power supply units! 

NANL-C500-RE Card and NANL-B500-RE Device: 

 All I/O signal pins at the NANL-C500-RE card and at the NANL-B500-
RE tolerate only 3.3 V signaling voltage! 

 Operation with 5 V signaling voltage may lead to severe damage to the 
NANL-C500-RE card or to the NANL-B500-RE device! 
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5.7.2.2 Electrostatically sensitive Devices 

NANL-C500-RE Card: 

Adhere to the necessary safety precautions for components that are 
vulnerable with electrostatic discharge. 
 

 
NOTICE 

Electrostatically sensitive Devices 
To prevent damage to the PC and the NANL-C500-RE, make sure: 

 that the NANL-C500-RE card is grounded via the endplate and the PC 
and make sure,  

 that you are discharged when you mount/demount the NANL-C500-RE 
card. 

 
 

USA: 
 

 
 

 
Electrostatically sensitive Devices 
To prevent damage to the PC and the NANL-C500-RE, make sure: 

 that the NANL-C500-RE card is grounded via the endplate and the PC 
and make sure,  

 that you are discharged when you mount/demount the NANL-C500-RE 
card. 
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5.7.3 Mounting Analyzer Card NANL-C500-RE to the PC 
 

 
Note: The installation sequence: 
1. Insert CD 
2. Install software 
3. Mount NANL-C500-RE card 
must be obeyed. Otherwise, there will be incorrect registry entries. This in 
turn leads to disturbances in subsequent installation of software updates. 

 

For mounting the netANALYZER card NANL-C500-RE to the PC handle as 
follows: 
 

 
 

 
Lethal Electrical Shock caused by parts with more than 50V! 
 Disconnect the power plug of the PC. 
 Make sure, that the power supply is off at the PC. 

 

1. Open the cabinet of the PC. 

2. Plug in the netANALYZER card NANL-C500-RE on a free PCI slot. 

3. Fix the netANALYZER card NANL-C500-RE card using the hole 
intended. 

4. Plug in the GPIO male connector to the female connector X40*. 
(*External Interface Input/Output Signals, see device drawing in section 
Device Drawing NANL-C500-RE on page 23.) 

5. Close the PC casing. 

6. Connect the PC to the power supply and switch on the PC. 
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5.7.4 Connecting Analyzer Device NANL-B500-RE to the Notebook 
 

 
Note: The installation sequence: 
1. Insert CD 
2. Install software 
3. Mount NANL-B500-RE device 
must be obeyed. Otherwise, there will be incorrect registry entries. This in 
turn leads to disturbances in subsequent installation of software updates. 

 

For connecting the netANALYZER device NANL-B500-RE to the Notebook 
handle as follows: 
 

1. Plug in the ExpressCard of the netANALYZER device NANL-B500-RE 
to a free ExpressCard slot at the Notebook. 

 

 
 

 
Device Destruction! 
 Connect only one 24 V DC power supply to the device. Otherwise this 
may lead to damage to the used power supply units! 

 

2. Connect the netANALYZER device NANL-B500-RE to an external 24V 
power supply.  
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5.7.5 Inserting Analyzer Card into the Communication Link 
Connect the netANALYZER card NANL-C500-RE or the netANALYZER 
device NANL-B500-RE via two patch cables with the Ethernet device 
connections, in parallel to the communication connection to be analyzed. 
Basically, different assemblies are possible. 
 

 
Note: To analyze the data transfer of a communication line between two 
devices, these devices must be connected to the same TAP (Test 
Application Point). 

 

In the following subsections typical application cases are described. 

5.7.6 Application Case 1 

Capturing and analyzing the Communication between two Devices 
 To capture the communication between two Ethernet devices, mount 

the netANALYZER card NANL-C500-RE or the netANALYZER device 
NANL-B500-RE over Ethernet cables as displayed in the picture below. 

 Connect both Ethernet cable only in TAP A (or in TAP B). 

Device 1 Device 2

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet Ethernet

Ethernet

Ethernet

 
Figure 36: Application Case1  

 

Furthermore, it analyzes the number of erroneous messages. 

A forwarding time of telegrams by a device can not be determined. See 
Application Case 2. 
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5.7.7 Application Case 2 

Application Case 2 is the typical Application Case  
In this case the netANALYZER card NANL-C500-RE or the netANALYZER 
device NANL-B500-RE can analyze the following procedures and 
parameters: 

• the communication between two devices each for two channels each, 

• the forwarding time through the device, 

• the cycle time and the jitter in the cyclically running protocols, 

• the changes of the data in the Ethernet frame through the device, 

• the number of erroneous telegrams. 

 

 To capture the communication of the two channels, mount the 
netANALYZER card NANL-C500-RE or the netANALYZER device 
NANL-B500-RE via Ethernet cables as shown in the picture. 

Device 1 Device 2 Device 3

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet

Ethernet

Ethernet

Ethernet

Ethernet

Ethernet

 
Figure 37: Application Case2 
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5.7.8 Application Case 3 

Like Application Case 2, but with further Devices 
This use case corresponds to the application case 2, but with the difference 
that further devices are between the two analyzed Ethernet channels. 

In this case the netANALYZER card NANL-C500-RE or the netANALYZER 
device NANL-B500-RE can analyze the following procedures and 
parameters: 

• the communication for two channels, 

• the forwarding time through several devices, 

• the cycle time and the jitter in the cyclically running protocols, 

• the changes of the data in the Ethernet frame through several devices, 

• the number of erroneous telegrams. 

 

 To capture the communication of the two channels, mount the 
netANALYZER card NANL-C500-RE or the netANALYZER device 
NANL-B500-RE via Ethernet cables as shown in the picture. 

Device 1 Device 2 Device 4Device 3

Ethernet Ethernet

Ethernet

Ethernet

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet
Ethernet

Ethernet
Ethernet

 
Figure 38: Application Case3  
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5.7.9 Application Case 4 

Like Application Case 2, but with Analysis of Input Signals 
This use case corresponds to the application case 2, but in addition to the 
Ethernet communication one to four input signals are included in the 
analysis. If an edge reversal at the digital input happens, a pseudo Ethernet 
frame with timestamp is created in the netANALYZER card NANL-C500-RE 
or the netANALYZER device NANL-B500-RE. 

In this case the netANALYZER card NANL-C500-RE or the netANALYZER 
device NANL-B500-RE can analyze the following procedures and 
parameters: 

• the communication between two devices for two channels, 

• the forwarding time through the device, 

• the cycle time and the jitter in the cyclically running protocols, 

• the changes of the data in the Ethernet frame through the device, 

• protocol-stack processing time from Ethernet frame reception to digital 
output switching, 

• the input signal events on the basis of time-stamps, 

• the number of erroneous telegrams. 
 

 
NOTICE! 

Device Destruction! 
 All I/O signals are only 3.3 V tolerant. 

 

USA: 
 

 
 

 
Device Destruction! 
 All I/O signals are max. 3.3 V tolerant. 

 

 To capture the communication of the two channels, mount the 
netANALYZER card NANL-C500-RE or the netANALYZER device 
NANL-B500-RE via Ethernet cables as shown in the picture. 

 



Start and use NANL-C500-RE or NANL-B500-RE 63/111 

netANALYZER NANL-C500-RE and NANL-B500-RE | Installation, Operation and Hardware Description  
DOC091110UM07EN | Revision 7 | English | 2010-03 | Released | Public  © Hilscher, 2007-2010 

 

The picture also shows schematically how a digital output signal is 
connected from the device to the digital input of the netANALYZER card 
NANL-C500-RE or the netANALYZER device NANL-B500-RE. 

Ethernet

Ethernet

Ethernet

IO Line

Device 2
Ethernet Device

with digital
Outputs

Device 1 Device 3

Ethernet

Ethernet

Ethernet

        NANL-C500-RE /
NANL-B500-RE

3
2
1
0 GPIO

TAP B

TAP A
 

Figure 39: Application Case4 – Recording of the Runtime in the Device 
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5.8 Activating Wireshark GPIO Dissector 
 

 
Note: GPIO events of the netANALYZER card NANL-C500-RE or the 
netANALYZER device NANL-B500-RE are decoded by Wireshark 
beginning with version 1.0.0. If after Wireshark installation the "Hilscher-
netANALYZER-GPIO event" is not displayed, the appropriate protocol 
must be activated in Wireshark once. 

 

Therefore: 

 Select in the menu under Edit > Preferences… in the left column under 
Protocols „Hilscher“ and at the right side activate Enable dissector. 

 
Figure 40: Wireshark: Preferences > Protocols 
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Figure 41: Wireshark: Preferences > … Enable dissector 
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 In addition in the menu under Analyze > Enable Protocols… activate 
the protocol „Hilscher“. 

 
Figure 42: Wireshark: Enable Protocols 
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5.9 Wireshark netANALYZER Plugin 
The Wireshark netANALYZER plugin allows to display in Wireshark the 
netANALYZER port number (the number of the port of the netANALYZER 
card) and specific error information for each Ethernet telegram.  
 

 
Note:  The Wireshark netANALYZER plugin is usable from Wireshark 
version 1.0.2. 

 

5.9.1 Deinstalling earlier Plugins 
Before installing the current plugin, the manually installed plugin of the 
netANALYZER versions 1.0-1.2 must be deinstalled manually. Also the 64-
bit and the 32-bit Wireshark netANALYZER plugin are not compatible. Each 
of them must be deinstalled before the other plugin can be installed. 
 

 
Note: The Wireshark netANALYZER plugin only can be deinstalled via  
Start > Settings > Control Panel > Software > Add or Remove Programs > 
Currently installed programs > Remove, if the plugin was already installed 
automatically before, otherwise the plugin must be deinstalled manually.  

 

Deinstalling the Plugin manually 
 Therefore delete the file „netanalyzer.dll“ or „netanalyzer_x64.dll“ from 

the directory “plugins” of the installed Wireshark software and replace it 
by the new plugin file. 

Or, if the plugin file with the first manual installation was stored to the user 
directory under "Application data" in the subdirectory "Wireshark\plugins", 
plugin file now must be deleted from this directory and must be replaced 
there by the current plugin file.  
 
 

5.9.2 Installing the Plugin automatically 
 

 
Note:  The Wireshark netANALYZER plugin is installed with the 
netANALYZER installation automatically, only if Wireshark was installed 
on the computer before. 

 

With the automatic installation the plugin is stored in the user directory 
under "Application data" in the subdirectory "Wireshark\plugins" 
(C:\documents and Settings\[user name]\Application data \wireshark\ 
plugins). Depending from the Windows® version the "Application data" 
directory can have also the name "appdata". 
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5.9.3 Installing the Plugin manually 
For questions about deinstalling the plugin refer to section Deinstalling 
earlier Plugins on page 67. 
 

 
Note:  If the Wireshark netANALYZER plugin was not installed 
automatically, it must be installed manually. This is required i. g., if 
Wirekshark was installed or actualized subsequently to the netANALYZER 
installation. 

 

 To install the plugin manually, copy from the directory “plugin” of the 
netANALYZER Installation CD the file „netanalyzer.dll“ or 
„netanalyzer_x64.dll“ into the directory “plugins” of the installed 
Wireshark software or to the user directory under "Application data" in 
the subdirectory "Wireshark\plugins".  

 Select the file „netanalyzer.dll“, if Wireshark works as 32-bit version.  

 Select the file „netanalyzer_x64.dll“, if Wireshark works as 64-bit 
version.  

The „plugins“ directory for Wireshark is located for Wireshark version 1.0.4. 
mostly under „C:\Program files\Wireshark\plugins\1.0.4“. For another 
Wireshark version the version number differs accordingly. 

After the netANALYZER plugin has been installed, it is activated 
automatically with the next start of the Wireshark program.  
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5.9.4 Wireshark: netANALYZER Info Block 
If the Wireshark netANALYZER plugin is installed correctly, additionally port 
and error information are displayed for .pcap files, which contains a 
netANALYZER info block.  

 
Figure 43: Wireshark: netANALYZER Info Block (Wireshark netANALYZER plugin was 
installed correctly): No Error  

 

 
Figure 44: Wireshark: netANALYZER Info Block (Wireshark netANALYZER plugin was 
installed correctly): Error Messages with additional text information 

 

5.9.4.1 Plugin not or not correctly installed 

 
Note: If a .pcap files contains a netANALYZER info block and the plugin is 
not or not correctly installed, then Wireshark can interprete the available 
additional information at the end of the telegram not correctly and displays 
telegram errors. In this case deactivate the generation of the info block or 
(better) install the netANALYZER plugin. 

 

If the plugin is not installed, then the info block can be recognized by 
„netANALYZER frame info block“ at the end of the telegram. 

 
Figure 45: Wireshark: netANALYZER Info Block without Plugin 
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5.9.5 Display Port Number in Wireshark Packet List  
To display the port information in the protocol tree of Wireshark directly in 
the packet list of Wireshark a new column can be inserted.  

 Select in Wireshark the menu Edit > Preferences   

 
Figure 46: Wireshark: Edit > Preferences 

 Select in the appearing window at the left side the entry User 
Interfaces > Columns.  

 
Figure 47: Wireshark: Preferences > User Interface > Columns  
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 Insert at the left a new user defined column with a click on the button 
New.  

 

 
Figure 48: Wireshark: Preferences > User Interface > Columns > New  

 Enter at Title (1) the heading name Port.  

 Select Custom for Format (2).  

 Enter for the Filter name (3) „hilscher.netanalyzer.port“.  
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Figure 49: Wireshark: Preferences > User Interface > Columns > Move  

 

 If necessary change the sequence of the columns with the buttons Up 
and Down.  

 Close the window via OK.  

 The number of the port now is displayed by an addition column.  
 

 
Figure 50: Wireshark: Port number in Packet list  
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5.9.6 FCS Handoff 
Many Wireshark plugins are not compatible with FCS handoff. To 
deactivate the FCS handoff: 

 Select in Wireshark Edit > Preferences   

 
Figure 51: Wireshark: Edit > Preferences 

 Select at the left side Protocols > netANALYZER.  

 
Figure 52: Wireshark: Preferences > Protocols > netANALYZER 

 Uncheck Handoff FCS. 

 Close the window via OK.  

 The FCS checksum is excluded from the analysis.  
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5.10 netANALYZER Software 
The netANALYZER software is a Windows® application that indicates the 
status information about the hardware and the received data packets. In 
addition, here the operator must define the filing paths for capturing the 
analysis data and initiate the conversion of the stored binary files (*.hea) to 
the WinPcap format (*.pcap). 

 

5.10.1 Starting and closing netANALYZER Software 
Starting the netANALYZER Software: 

 Select via the Windows® start menu Start > Programs > Hilscher 
GmbH > Hilscher netANALYZER. 

 

Closing the netANALYZER Software: 

 Select via the netANALYZER Software menu File > Close. 

 

5.10.1.1 Check for Hardware and Version Verification Device Driver 
 

 
Note: During initializing of the netANALYZER software the hardware is 
checked and the device driver version is verified.  

 If the hardware is not installed, the following error message is displayed: 
Incompatible driver version. In the netANALYZER main window in 
the status bar the message „Error in driver“ is displayed. 

 If the device driver or the netANALYZER software is not up to date and 
compatible, the following error message is displayed: Please check 
driver version and installation. 
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5.10.2 netANALYZER – Main Window 

 
Figure 53: netANALYZER – Main Window 
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Parameter Meaning Range of Value / 
Value 

Status Defines the operating status of the firmware RUN / STOP 
Link/ TAP A (Port 0, Port 1),  
TAP B (Port 2, Port 3) 

Status of the link connected to the port.  
Capturing for this port on/off, deactivated 
ports are greyed out.  

UP / DOWN 
Selected/unselected 

Filter/ TAP A (Port 0, Port 1),  
TAP B (Port 2, Port 3) 

Indicates for each Port 0 to Port 3 the status 
of the filter.  
If the syntax "ACTIVE" is displayed in red, the 
filter is used, but it is not yet saved, and it will 
be lost after a new start of the software. 

ACTIVE, INACTIVE 

Transparent Mode If checked, any telegram data, including the 
preamble and SFD are displayed or captured. 
For further information refer to section 
Transparent Mode on page 101. 

checked / 
unchecked, 
Default: unchecked 

Frames received OK Number of frames received 0 to 2 ^32 -1 

Check sequence errors Number of Sequence errors occurred 0 to 2 ^32 -1 

Alignment Errors Number of alignment errors by collision, frame 
is not Byte-Align 

0 to 2 ^32 -1 

MII RX_ER errors Number of MII RX_ER errors 0 to 2 ^32 -1 

Short frames Number of short frames 0 to 2 ^32 -1 

Frames too long Number of frames too long 0 to 2 ^32 -1 

Start of frame delimiter errors Number of SFD errors 0 to 2 ^32 -1 

Preamble too long Preamble is too long  0 to 2 ^32 -1 

Preamble too short Preamble is too short 0 to 2 ^32 -1 

Frames rejected by filter Number of frames rejected by the filter 0 to 2 ^32 -1 

Minimum Inter Frame Gap [ns] Minimum measurable gap between two 
telegrams on the line 

0 to 327670 ns 

Bus Load % Busload in percentage 
Note: For NANL-C500-RE TAP B the PHY 
transmission rate can not be evaluated. For 
this reason, here the busload signal 10 Mbit/s 
is faulty. But, if in the PHY configuration 
dialog* the setting is changed to 10 Mbit/s 
manually (*see section PHY Settings on page 
86), the busload signal can be displayed 
correctly. This is not true for NANL-B500-RE. 
Here everything automatically is diplayed 
correctly. 

0 – 100% 

Recording Time Recording Time, in „hours.minutes.seconds“ 00.00.00 h 

Analysis Mode Selection list Data Capturing or Timing 
Analysis 
(See section Data Capturing on page 87 and 
section Timing Analysis on page 91.) 

Capture Data,  
Timing Analysis 

Start Starting and stopping Data Capturing 
(See section Starting Data Capturing on page 
87.) 

 

Convert Converting Binary Files into WinPcap Format 
(See section Converting Binary Files into 
WinPcap Format on page 88.) 

 

More see next page 
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Parameter Meaning Range of Value / 
Value 

Status Bar 
Status: Indicates the Status of the application, of the 

firmware or of the driver:* 
 

GPIO: Indicates the status of the external inputs.*  

* To read detailed explanations to the single status bar messages refer to section Status Bar Messages on 
page 78. 

Table 17: netANALYZER – Main Window: Parameters and Status Bar  
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5.10.3 Status Bar Messages 
In the status bar of the main window of the netANALYZER software 
different status messages are displayed for the status of the application, for 
the firmware or for the driver or for the status of the external GPIO inputs 
and for the used filter. The following table lists all sorts of status messages. 

Significance of the color of the text status messages:  
Black: Actual status message  
Red: Error message  
Green: Function enabled 

Status: GPIO: Description in the Status 
Bar:  

Description 

 X GPIO: Start/Stop manual  Manually starting and stopping of the capturing process 

 X GPIO: Start on event  The start of the capturing process, is triggered via a 
GPIO event. 

 X GPIO: Stop on event  The stop of the capturing process, is triggered via a 
GPIO event. 

 X GPIO: Start/Stop on event  The start and stop of the capturing process, are 
triggered via an event. 

X  Status: Error in driver The hardware is not installed or not compatible. 

X  Status: Capture Data 
ready   

The application is ready. 

X  Status: Capture in 
progress 

The application is in the capturing mode. 

X  Status: Capture stopped 
manually 

The capturing process was manually stopped. 

X  Status: Capture stopped 
automatically 

The capturing process was automatically stopped by the 
application. 

X  Status: Error in registry  The necessary entries in the registry were faulty or 
absent. 

X  Status: Error, can't open 
directory 

Access to the specified directory was denied. (Example: 
it does not exist) 

X  Status: Successfully 
loaded settings 

All settings could be loaded successfully. 

X  Status: preparing start of 
Firmware 

Starting the capturing process. 

X  Status: preparing stop of 
Firmware 

Stopping the capturing process. 

X  Status: File not found  The specified file could not be found. 

X  Status: Can't open file The specified file could not be opened. 

X  Status: Converting data  The conversion of captured data was proceeded. 

X  Status: Conversion 
completed 

The conversion of the captured data was completed 

X  Status: Mode not available The selected mode could not be initialized correctly. 

X  Status: Mode available The conversion of the recorded data was completed. 

X  Status: Error: "XXXX" An error has been occurred, the error code of which is 
XXXX. 

X  Status: Error An error has been occurred. The error code could not be 
represented yet. 

Table 18: Status Bar Messages 
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5.10.4 Performing File Settings 
 Select Settings >File Settings. 

 
Figure 54: File Settings 

 

Control Explanation Range of Value / 
Value 

Max. number of 
.hea files 

Maximum number *.hea files, which is to be saved 
before the capturing is stopped. 

Standard file size: 
1GB 

Ring-buffer mode If checked, the capturing data are stored to the ring 
buffer. 
If unchecked the capturing data are stored to a stack 
buffer (stack buffer mode) and data capturing is 
finished automatically, when all .hea files are filled 
completely. 

checked / 
unchecked, 
Default: checked 

Name of .hea files Name for *.hea files. 1 .. 255 characters 

Path of .hea files Path to be defined by the operator, under which the 
netANALYZER driver shall save the binary file (*.hea). 

 

Table 19: Description File Settings 

 

 Determine in the window File Settings under Max Number of .hea 
files the number of binary files to be stored. 

 Check Ring-buffer mode to define, that the capturing data are to be 
stored to the ring buffer. 

 Under Name of .hea files define the systematic name of the *.hea files. 

 Under the Path of .hea files determine where the binary files will be 
stored. 

 Click to the OK button to close the window File Settings. 
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5.10.4.1 Application Message 

 The query Do you want to save the Configuration is displayed when 
in the window File Settings a change has been made and the Cancel 
button is clicked. 

 
Figure 55: netANALYZER – Do you want to save the Configuration? 

 Answer the question with Yes, if you want to save the changes. 

 Answer the question with No, if you want the changes. 
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5.10.5 GPIO Settings 
 Select Settings >GPIO Settings.  

 

 

 

 

 

 

Figure 56: GPIO Settings 

 

 
Note: If for the start or the end of the capturing process a GPIO event is 
selected, that will not be checked (e. g. “OFF”), the data capturing process 
will not start. 

 
 

Control Explanation Range of Value / 
Value 

GPIO 
Configuration / 
GPIO 0 – GPIO 3 

Selection list, which GPIO event shall be assigned to 
which input (GPIO) and is displayed as a pseudo frame 
in Wireshark.  
GPIO event: off (no event), rising edge or falling edge  

off 
rising edge 
falling edge 

Trigger 
Configuration / 
Start on, Stop on 

Selection list for the start and the end of the capturing 
of the GPIO input. 
Manual: The capturing process is started and stopped 
manually, via the netANALYZER user interface. 

manual 
GPIO 0 – GPIO 3 

Delay Time after the stop event during which still data are 
captured. 

0 … 40.000.000 μs 

Table 20: GPIO Settings 

 

 Under GPIO Configuration define which GPIO event shall be assigned 
to which input (GPIO). 

 Under Trigger Configuration define the GPIO event for the start and 
the end of the data capturing and the delay time. 
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5.10.6 Filter Settings 
To reduce the amount of data or to select analysis data more specific one 
or two filter masks can be defined. Already defined filters can be saved and 
reloaded. 

The filter mask checks the first 512 Bytes of the frame, consisting of the 
destination MAC address (Byte 0 to 5), the source MAC address (6 to 11 
Bytes), the Ether-type (Byte 12 and 13) in the first two Bytes for the frame 
data. 
 

 
Note: All predefined filters are provided with a write protection. I. e., the 
filter masks defined under Enable Filter A or Enable Filter B can not be 
changed and the values for „Mask“ and „Value“ in the filter mask can not 
be edited.  

 

Opening Filter Options: 

 Select Settings >Filter Settings. 

 
Figure 57: FiltersForm 
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Control Explanation Range of Value / 
Value 

Port Filter settings page per Port Port 0, Port 1,  
Port 2, Port 3 

Filters Selection list as tree structure with predefined filters for 
different Ethernet protocols.  
To add a newly defined filter the tree structure can be 
enlarged. E. g. via right click on Modbus/TCP > 
Exceptions the menu Copy Filter, Rename, Delete is 
opened to copy, rename or delete a filter.  

Predefined filters 
an newly defined 
filters 

Copy Filter Copies the filter selected under the Filters and adds 
this one as copy below. 

 

Save Filter Saves the newly defined filter.  
Select Filter for 
this Port 

Defines the under Filters selected filter for this port.  

Apply to All Ports The selected filter is applied to all ports.   
Enable Filter A 
Enable Filter B 

Definable filter masks: „Filter A“ or „Filter B“ or „Filter A 
and Filter B“. 
All predefined filters are provided with a write 
protection. 

checked:  
Filter A, Filter B, 
Filter A and  
Filter B 

Filter Matrix Matrix for entering byte- and mask values. 1-512 byte 

   Offset Byte Offset for each 8 Byte of a frame, which are 
indexed by the Byte Index. 

0x0 to 0x7 

   Index Byte Index, which defines 64 x each 8 Byte of a frame. 0x000 to 0x1F8 

   Value Assessed value under restriction of the mask. 
Entry in hexadecimal notation 

0 … FF hex 

   Mask Mask 
Value = 0: Value of the value-Bit is not included. 
Value = 1: Value of the value-Bit is included. 
Entry in hexadecimal notation 

0 … FF hex 

Always accept 
corrupted Frames 

Faulty Frames should always be displayed, even if 
they would be filtered out otherwise. 

 

Selection List 
Filter Configu-
ration 

Selection list of the possible combinations of the 
following filter options:  
1. Accept / reject value  
2. Filter A and / or filter B  
3. Value must be true or should not apply  
4. And or link of the values  
(In the case of multiple filters)  
Depending on what filter/s are selected, the list box 
offers different options. 

 

Selected Filter: Under Filters selected filter  

Selected 
Protocol: 

Under Filters selected protocol  

Table 21: Filter Settings – Window FiltersForm 
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5.10.6.1 Selection List Filter Configuration 

The selection list filter configuration offers the following options: 
 

Filter A Filter B Configuration:  
X X Accept, if filter A matches and filter B matches.  

X X Accept, if filter A doesn’t match and filter B matches. 

X X Accept, if filter A matches and filter B doesn’t match. 

X X Accept, if filter A doesn’t match and filter B doesn’t match. 

X X Accept, if filter A matches or filter B matches.  

X X Accept, if filter A doesn’t match or filter B matches. 

X X Accept, if filter A matches or filter B doesn’t match. 

X X Accept, if filter A doesn’t match or filter B doesn’t match. 

X X Reject, if filter A matches and filter B matches.  

X X Reject, if filter A doesn’t match and filter B matches. 

X X Reject, if filter A matches and filter B doesn’t match. 

X X Reject, if filter A doesn’t match and filter B doesn’t match. 

X X Reject, if filter A matches or filter B matches.  

X X Reject, if filter A doesn’t match or filter B matches. 

X X Reject, if filter A matches or filter B doesn’t match. 

X X Reject, if filter A doesn’t match or filter B doesn’t match. 

X  Accept, if filter A matches.  

X  Accept, if filter A doesn’t match.  

X  Reject, if filter A matches.  

X  Reject, if filter A doesn’t match.  

 X Accept, if filter B matches.  

 X Accept, if filter B doesn’t match.  

 X Reject, if filter B matches.  

 X Reject, if filter B doesn’t match.  

Table 22: Combinations of the Selection List Filter Configuration 
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5.10.6.2 Defining, saving, loading Filter Settings 

To define, to save or to load filter settings for one or several filters, proceed 
as follows: 

1. Enable checkbox Enable Filter A or Enable Filter B or Enable Filter A 
and Enable Filter B. 

2. Enter the value to be assessed under restriction of the mask in the line 
Value. 

Entry in hexadecimal notation, value range from 00 to FF. 

3. Enter the desired mask in the line Mask. 

Value = 0: Value of the value-Bit is not included. 

Value = 1: Value of the value-Bit is included. 
 

Value in Mask Value used for the Filter 
FF The value FF effects, that the value in ‚Value’ is used for the 

Filter. 

00 The value 00 effects, that the value in ‚Value’ is not used for the 
Filter. 

0F The value 0F effects that lower 4 Bits of the value in ‚Value’ are 
used for the Filter. 

F0 The value F0 effects, that upper 4 Bits of the value in ‚Value’ 
are used for the Filter. 

Table 23: Value used for the Filter 

 

Entry in hexadecimal notation, value range from 00 to FF. 

Example: 
 Destination MAC Address Source MAC Address Data 

Type 
User Data 

Byte 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 
Value 00 15 CF DD DA BE 00 00 00 00 00 00 00 00 00 00 
Mask FF FF FF 00 00 00 00 00 00 00 00 00 00 00 00 00 

Table 24: Example Defining Filter Settings 

The filter shown in the example filters for frames beginning with 00,15, CF. 
 

4. Enable Always check accept corrupted frames. 

 Faulty Frames are always displayed, even if they would be filtered out 
otherwise. 

5. Select in the selection list filter configuration a combination of the filter 
options. 

Depending on what filter/s are selected, the list box offers different options. 

6. Save the current filter via Save Filter.  
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5.10.7 PHY Settings 
Via PHY Settings for Port 0 to Port 3 the data transmission rate can be set 
manually to a defined value. Then every Ethernet telegram is captured from 
the beginning on. With the setting Auto no data capturing is provided 
during auto negotiation.  
 

 
Note: For a good portion of all applications the Auto setting for PHY 
Configuration is comfortable. A typical application when the transmission 
rate must be defined manually to 100 Mbit/s, is given e. g. with the 
PROFINET / Fast-Startup.  

 

Proceeding, how to set the transmission rate: 

 Select Settings > PHY Settings.  

 

 

 

 

 

Figure 58: PHY Settings 

 

Control Explanation Range of Value / 
Value 

PHY 
Configuration / 
Port 0 to Port 3 

For Port 0 to Port 3 the transmission rat can be set 
manually per port. 

Auto,  
10 Mbit/s,  
100 Mbit/s,  
Default: Auto 

Table 25: GPIO Settings 

 
 

 Under PHY Configuration > Port 0 to Port 3 each set the transmission 
rate. 
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6 Analysis Methods 
6.1 Data Capturing 

6.1.1 Select Capture Data Mode 
 Select in the netANALYZER window in the selection list for the analysis 

mode the list item Capture Data. 

 
Figure 59: netANALYZER – Selection List for the Analysis Mode 

 The data capturing now can be started.  

6.1.2 Starting Data Capturing 

6.1.2.1 Starting Capturing 

 If necessary activate or deactivate capturing ports in the main windows.  

 Click in the window netANALYZER on the Start button. 

 In the window netANALYZER the menu bar and buttons are disabled. 
Furthermore, the Start button now is displayed as Stop button. 

 The capturing process of the received Ethernet frames starts. 
  

 
Note: If in the netANALYZER software under Settings > File Settings 
Ring-buffer mode is: 

 checked, the capturing data are stored to the ring buffer,  

 unchecked, the capturing data are stored to a stack buffer (stack buffer 
mode) and data capturing is finished automatically, when all .hea files 
are filled completely. 
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6.1.3 Converting Binary Files into WinPcap Format 
 Click in the window netANALYZER to the button Convert. 
 In the window Path of .hea file and .pcap files are displayed: 

• Under .hea File > All filtered .hea files for this name or capture: the 
filtered *.hea files. 

• Under .pcap files > .pcap files that will be generated: the *.pcap files 
to be converted. 

 
Figure 60: netANALYZER – Path of .hea file and .pcap files 

 

Control Explanation 
.hea File 
Path Path to be defined by the operator, under which the netANALYZER 

driver shall save the binary file (*.hea). 
Here the path defined in the window File Settings can be changed. 

All filtered .hea 
files for this name 
or capture 

Edited list of .hea files 

Table 26: Description Path of .hea file and .pcap files - .hea File 

.hea File 
1. Under the Path determine where the binary files will be stored. 

 Under .hea File > Path click to . 

 In the window Search Folder define the file location. 
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Control Explanation 
.pcap files 
Path Path to be defined by the operator, under which the netANALYZER 

software shall save the WinPcap file (*.pcap). 

File name Systematic file name for the *.pcap files. The netANALYZER 
software still assigns for every file in addition an ongoing number in 
the file name. 

.pcap files that 
will be generated 

Preview of the .pcap files that will be generated 

Append date/time 
to pcap file name 

Date and time are added to the file name or not. 

Include FCS in 
.pcap-files 

Checkbox whether the Ethernet checksum must be with the PCAP 
file or not. 
(Some Wireshark-dissectors do not support FCS.) 

Include corrupted 
frames in .pcap 
file 

If this option is activated, also incorrect frames will be transferred into 
the .pcap file. If the option is deactivated only correct telegrams are 
saved to the .pcap file. 

Append 
netANALYZER 
information block 

Inserts the netANALYZER info block into the .pcap file to have 
additional information for every telegram. Requires to install the 
netANALYZER Wireshark plugin. 

Convert Conversion of binary files into WinPcap format. 

Table 27: Description Path of .hea file and .pcap files - .pcap files 

 

.pcap files 
2. To change the path to store .pcap files: 

 Under .pcap files > Path click to . 

 In the window Search Folder define the file location, where to store 
WinPcap files. 

 Data are saved in multiple .pcap-files, 50 MB each. 
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3. Via Convert convert the binary files to the WinPcap format. 

 In the window Conversion the conversion process details are 
displayed. 

 
Figure 61: netANALYZER – Conversion 

Control Explanation 
.hea files Display of the name of the currently created binary file  

.pcap files Display of the name of the currently converted WinPcap file 

Progress Progress bar for the conversion in KByte 

Table 28: Description Conversion 

4. After the conversion was completed successfully, the window Path of 
.hea file and .pcap files closes automatically. 
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6.2 Timing Analysis 

6.2.1 Selecting Timing Analysis Mode 
 Select in the netANALYZER window in the selection list for the analysis 

mode the list item Timing Analysis. 

 
Figure 62: netANALYZER – Selection List for the Analysis Mode 

 The window Timing Analysis is displayed. 

6.2.2 Timing Analysis Window 
If the timing analysis has been selected, the following window is 
automatically displayed at the screen additionally: 

 
Figure 63: netANALYZER – Timing Analysis Window, four Timing Analysis Windows 

Up to four analysis windows here are represented at once, the size of the 
individual windows can be varied about the divider. 
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One analysis window in detail consists of the following components: 

 
Figure 64:netANALYZER – Timing Analysis Window 

 

Control Explanation Range of Value / 
Value 

Title Line  
(Tag field) 

Here the user can enter an arbitrary title for his 
histogram. 

 

Port Selection 
(Start Port / Stop 
Port) 

Indicates the analysis ports. The timing analysis is 
always carried out for frames or events between start 
and stop port. Choice (port 0-3, GPIO 0-3). More 
detailed description for the port choice and different 
analysis methods see below. 

 

Y Axis Scaling Linear or logarithmic  

Measured Value 
Display 

Here, the minimum and maximum measured values 
and the arithmetic mean value (left side) are displayed, 
in addition (right side) the number of measured values 
are displayed, and also the number of measured 
values below and above the display area of the 
histogram. (The display area can be found in the 
histogram settings.) 

Left side:  
Min Time,  
Av Time,  
Max Time 
Right side:  
Samples,  
Below Range, Over 
Range 

Histogram: 
(Frames/  
Time Diagram) 

Graphical representation of the distribution function of 
all measurements. 

 

Histogram Settings 
Clear Values Deletes all values recorded till now for the current 

histogram and starts with the analysis once more. 
 

Export Stores measured values and histogram data into text 
file. 

 

Auto-Scale / 
Manual Scale,  
Min / Max 

Selection list to select the automatic scaling of the x-
axis or to the manual scaling by means of the two time 
data displayed at the right side. Manual Scale can also 
be set via mouse action. 

 

Table 29: Description Timing Analysis Window 
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6.2.3 Examples for the Possibilities of the Timing Analysis 
 

 
Note: Normally certain cyclical frames form the base for the timing 
analysis, so e.g. the Sync telegram at PROFINET or MDT0 at Sercos III. It 
is of importance that only these frames are brought to the timing analysis. 
Therefore before the start of the analysis a corresponding filter must be 
set, which prefilters possible acyclic or additional cyclical telegrams and 
exclusively lets through the frame to be analyzed. 

 

 

6.2.3.1 Cycle Time Measurement 

Device 1 Device 2

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet Ethernet

Ethernet

Ethernet

 
Figure 65: Application Case1 – Example Cycle Time Measurement 

For the cycle time measurement, it is sufficient to insert one TAP of the 
netANALYZER card NANL-C500-RE or the netANALYZER device NANL-
B500-RE into transmission distance. Here the differences between two 
successive frame times are formed, and gives the cycle time as a result. In 
the port selection as start and as destination port correspondingly the same 
port must be selected. 
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6.2.3.2 Forwarding Time Measurement 

Device 1 Device 2 Device 3

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet

Ethernet

Ethernet

Ethernet

Ethernet

Ethernet

 
Figure 66: Application Case2  - Example Forwarding Time Measurement 

For the forwarding time measurement the netANALYZER card NANL-
C500-RE or the netANALYZER device NANL-B500-RE must be inserted 
before and behind the device to be examined. Here the time difference 
between the telegram coming in on the one side of the device is measured 
up to the next telegram on the other side of the device. The port selection 
correspondingly must be carried out from a port of the first TAP to a port of 
the second TAP: Difference of port 0/1 to port 2/3. or for measurement to 
the opposite direction port 2/3 to port 0/1. 
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6.2.3.3 Stack Operating-Time Measurement 

Ethernet

Ethernet

Ethernet

IO Line

Device 2
Ethernet Device

with digital
Outputs

Device 1 Device 3

Ethernet

Ethernet

Ethernet

        NANL-C500-RE /
NANL-B500-RE

3
2
1
0 GPIO

TAP B

TAP A
 

Figure 67: Application Case 4 – Recording of the Runtime in the Device – Example Stack 
Operating-Time Measurement 

For stack operating-time measurement the difference between a port of the 
Ethernet channel and a GPIO can be formed. Here, e. g. a cyclical process 
data frame on port x becomes supervised as well as the appearance of a 
digital switching event on GPIO y after this frame was processed in the 
software stack. 
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6.2.3.4 Response-Time Measurement 

Device 1 Device 2

NANL-C500-RE /
NANL-B500-RE

TAP B

TAP A

Ethernet Ethernet

Ethernet

Ethernet

 
Figure 68: Application Case 1 – Example Response-Time Measurement 

For response-time measurement the difference in time between two 
different ports on the same TAP is measured. Here, for example, the 
incoming frame on port 0 is recorded, and the outgoing response frame on 
port 1. 
 

 
Note: Because of the auto crossover function of most of the RTE systems, 
the assignment of port 0 and 1 or port 2 and 3 can change between 
different test runs. 
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6.3 Information to Analysis 

6.3.1 Timestamp 
The Figure hereafter shows for „Ethernet Mode“ or for „Transparent Mode“, 
where the timestamp for the associated data packet is taken. 

 
Figure 69: Message Timestamp-Point for „Ethernet Mode“ and „Transparent Mode“1 

„Ethernet Mode“ (Standard Capturing):  
In „Ethernet Mode“ the time stamp is taken at the reception of the SFD 
(Start-of-Frame-Delimiter). 

 „Transparent Mode“ (SFD2 is disturbed):  
In „Transparent Mode“ the time stamp is taken at the always at the very 
front with the lateral growth, i. e. at the proper start of the frame. Here 
preamble and SFD are not interpreted. 

 

 

                                                 
1 „DV“ = Data Valid, „D0..3“ = Data, „5 d“ = SFD identifier 
2 „SFD“ = Start-of-Frame-Delimiter 
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6.3.2 Input Signal as pseudo Frame 
For GPIO events a special pseudo Ethernet frame is generated by the 
firmware. This allows Wireshark with a special dissector to display GPIO 
events within the frame list. 

“ 
 

 
Note: A special MAC address is used, of the Hilscher range 
00:02:A2:FF:FF:FF. This address must never be assigned to a real 
address. 

 

 

Format of the Pseudo Frames (Length: 17 Bytes): 
6 Bytes Destination 
MAC Address 

6 Bytes Source 
MAC Address 

Ethertype ID GPIO Number Edge 
(pos/neg) 

00:02:A2:FF:FF:FF 00:02:A2:FF:FF:FF 0x88FF 0x00 0x00 … 0x03 0x00 … 0x01 

Table 30: Format of the Pseudo Frames 
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6.3.3 Determining Cycle Time and Forwarding Time (Capturing-
Mode) 

The parameters cycle time and forwarding time at the capturing-mode can 
be determined by the use of Wireshark from the captured and to the pcap 
format converted analysis data. The procedure, how to determine the 
parameters, varies with the different types of communication. 

 

Cycle Time (Example PROFINET IRT) 

The cycle time is the time difference between the time stamps of two 
consecutive frames of a cyclically occurring frame type (such as the Sync-
frame). 

1. Open in Wireshark the *.pcap file of the captured and into in the pcap 
format converted analysis data. (see section Starting Data Capturing on 
page 87 and section Converting Binary Files into WinPcap Format on 
page 88). 

2. Take in Wireshark the time difference between the time stamps of two 
successive frames of a cyclically occurring frame type. 

 

Forwarding Time (Example PROFINET IRT) 

The forwarding time is the time difference between the time stamps of a 
cyclically occurring frame after and of a cyclically occurring frame before a 
device (e. g. Sync-frame). 

1. Open in Wireshark the *.pcap file of the analysis data, captured after or 
before a device and converted into in the pcap format. (see section 
Starting Data Capturing on page 87 and section Converting Binary Files 
into WinPcap Format on page 88). 

2. Take in Wireshark the time difference between the time stamps of a 
cyclically occurring frame after and of a cyclically occurring frame 
before a device. 
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6.3.4 Determining Cycle Time and Forwarding Time (Timing 
Analysis) 

The parameters cycle time or forwarding time can be found out at the data 
capturing mode in the netANALYZER timing analysis window. 

 

 
Figure 70: netANALYZER – Timing Analysis Window 

 

Cycle Time 

 To find out the cycle time, select at Start Port and at Stop Port each 
the same port. 

 

Forwarding Time 

 To find out the forwarding time, select at Start Port and at Stop Port 
each the port in front of or after the device, for which the forwarding 
time shall be found out. 
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6.4 Transparent Mode 
The Transparent Mode is used with the data capturing to register any 
telegram data, i. e., any bits transmitted including the frame data, preamble 
and SFD (=Start of Frame Delimiter). 
 

 
Note: The usage of the Transparent Mode only makes sense with a 
100 Mbit connection. 

 

The figure below shows the basic principle of an Ethernet frame (Ethernet 
telegram) in the in the Standard Ethernet Mode or in the Transparent 
Mode.  

 
Figure 71: Basic Principle of an Ethernet Frame in the Standard Ethernet Mode or in the 
Transparent Mode 

As during the Standard Ethernet Mode the preamble and the SFD (=Start 
of Frame Delimiter) are not included to the telegram, these parts are 
captured in the Transparent Mode. 

 
 

 
Figure 72: Ethernet Telegram (Ethernet Frame) in Wireshark in the Standard Ethernet Mode 
or in the Transparent Mode 
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7 Troubleshooting 

General 
 Check, if the preconditions are served for the operation of the 

netANALYZER card NANL-C500-RE or the netANALYZER device 
NANL-B500-RE: 

Further information to this you find in section Preconditions for Installation 
and Operation on page 32. 

Link is not recognized 
 

 
Note: For 10-Mbit/s-connections and for increased bus load the PHY 
(physical interface) can not correctly detect the link. If in such a case in the 
netANALYZER main window under Link DOWN is displayed, for 
troubleshooting the speed must be set manually to 10 Mbit/s in the PHY 
Settings dialog. 

 

LINK-LED 
 Check using the LINK LED status, if a connection to the Ethernet is 

established.  

Further information to this you find in chapter LED on page 103. 

Cable 
 Check that the pin occupation of the used cable is correct. 

 

Analyzer Device NANL-B500-RE: 
 Check that the power supply of the device is connected to the mains 

voltage. 
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8 LED 
8.1 LED NANL-C500-RE and NANL-B500-RE 

LED Color State Meaning 

green On Operating System running 

yellow Flashing cyclic at 
1Hz 

Device indicates boot error 

yellow Static Bootloader is waiting for booting procedure / card or  device 
deinitialized 

SYS  

-  Off Power supply for the device is missing or hardware defect 

green On Capturing process active STA0 

red On Capturing process inactive 

green Single Flash / On Activity by signals on the GPIO STA1 

red On Error between PCI and firmware to the PC 

green On A connection to the Ethernet exists LINK / 
RJ45 Ch0 
u. Ch1 - Off The device has no connection to the Ethernet  

RX/TX / 
RJ45 Ch0 
u. Ch1 

yellow Flashing / On The device sends/receives Ethernet frames 

Table 31: LED NANL-C500-RE and NANL-B500-RE 

 
 

Indicator States 
Indicator state Definition  
On The indicator is constantly on. 
Off The indicator is constantly off.  
Blinking The indicator turns on and off phase with a frequency of 

2,5 Hz: on for 200 ms followed by off for 200 ms. 
Single Flash The indicator shows one short flash followed by an off phase. 

The interval period for the flash when triggering a GPIO event 
is 100 ms. 

Table 32: Indicator States  
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9 Technical Data 

 
Note: All technical data are temporarily and can be altered without notice. 

9.1 Analyzer Card NANL-C500-RE 
Item NANL-C500-RE 
PC Interface PCI V2.3, 33 MHz, 32-Bit Dual-Port Memory; DPM and DMA 
Required 
PCI Connector 

PCI slot (3.3 V) 

Data Throughput  
PCI-Bus 

Tested to 35 MB/s 

Dual-Port Memory Size 64 KByte 
Function Passive Ethernet analyzer for RT-Ethernet systems; analyzes the data in a 

communication link and captures the incoming Ethernet frames. Additionally, 
events of four digital inputs can be captured.  

Communication Receipt of Ethernet frames 
Channels / Ports 2 communication channels with integrated TAP (TAP B, TAP A),  

and each with two ports for capturing data in both directions 
(together 4 Ports: Port 0 to Port 3) 

Filter 2 Filter on the first 512 Bytes of the Ethernet-Frames  
(Source and Destination MAC Address, Ether-Type and 498 following Bytes) 

Time Stamp Resolution 10 ns 
LED Display SYS, STA0, STA1, 4x Link, 4x Activity: 

SYS / System Status, 
STA0 / Capturing active / inactive, 
STA1 / Event signal detected, 
Link and Activity per channel   

IO Interface External Interface Input/Output Signals (female connector X40): 
4 digital Inputs/Outputs, 3.3 V / 10mA 
The 4 digital inputs / outputs of the external interface input / output signals are 
configured by the software only as inputs. 

GPIO Resolution for events > 150 µs 
Analyzer Software 
(recommended) 

Open Source Wireshark 

Ethernet Frame Types Ethernet II (10 BASE-TX / 100 BASE-TX) 
Data Format Open WinPcap data format 
Processor netX 500 with ARM 926 CPU 
Reception Rate 10/100 MBit/s 
Ethernet Interface Ethernet RJ45 Socket, potential free 
Ethernet Cable 2 x 2 Twisted-Pair cupric cable, CAT5 (100 MBit/s), 

Length of cable max. 100 m 
Power Supply +3.3 V ±5 % / 800 mA 
Dimensions (L x W x D) 137 x 107 x 17,5 mm 
Operating Temperature 0 °C ... 55 °C 

Table 33: Technical Data Analyzer Card NANL-C500-RE 
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9.2 Analyzer Device NANL-B500-RE 
Item NANL-B500-RE 
PC Interface ExpressCard 34, PCI Express Base Specification Revision 2.0 and  

PCI Express to PCI/PCI-X Bridge Specification Revision 1.0 
Required 
PCI Connector 

ExpressCard Slot (for notebook) 

Data Throughput  
PCI-Bus 

Tested to 35 MB/s 

Dual-Port Memory Size 64 KByte 
Function Passive Ethernet analyzer for RT-Ethernet systems; analyzes the data in a 

communication link and captures the incoming Ethernet frames. Additionally, 
events of four digital inputs can be captured.  

Communication Receipt of Ethernet frames 
Channels / Ports 2 communication channels with integrated TAP (TAP B, TAP A),  

and each with two ports for capturing data in both directions 
(together 4 Ports: Port 0 to Port 3) 

Filter 2 Filter on the first 512 Bytes of the Ethernet-Frames  
(Source and Destination MAC Address, Ether-Type and 498 following Bytes) 

Time Stamp Resolution 10 ns 
LED Display SYS, STA0, STA1, 4x Link, 4x Activity: 

SYS / System Status, 
STA0 / Capturing active / inactive, 
STA1 / Event signal detected, 
Link and Activity per channel   

IO Interface External Interface Input/Output Signals (female connector X40): 
4 digital Inputs/Outputs, 3.3 V / 10mA 
The 4 digital inputs / outputs of the external interface input / output signals are 
configured by the software only as inputs. 

GPIO Resolution for events > 150 µs 
Analyzer Software 
(recommended) 

Open Source Wireshark 

Ethernet Frame Types Ethernet II (10 BASE-TX / 100 BASE-TX) 
Data Format Open WinPcap data format 
Processor netX 500 with ARM 926 CPU 
Reception Rate 10/100 MBit/s 
Ethernet Interface Ethernet RJ45 Socket, potential free 
Ethernet Cable 2 x 2 Twisted-Pair cupric cable, CAT5 (100 MBit/s), 

Length of cable max. 100 m 
USB Plug* Mini B USB Plug (5-pin) 
SD* Micro SD Card Slot 
Switch * RUN / STOP / RESET 
 * for future use only 
Connector  
24V Voltage Supply 

Combicon: 0V/+24V/PE  alternatively Female Connector +24V 
(only alternative use permitted!), 
Maximum permitted cable length: 3 m 

Power Supply nominal 24V DC / 180mA / 4,3W 
Range 18V ... 30V DC 
Dimensions (L x W x D) 115 x 62 x 133 mm 
Operating Temperature 0 °C ... 55 °C 

Table 34: Technical Data Analyzer Device NANL-B500-RE 
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11 Glossary 
ASIC netX 500  

Application Specific Integrated Circuit  

Real-Time capable controller for short response times 

CSV 

Comma Separated Value 

DMA 

Direct Memory Access 

DPM 

Dual-Port Memory 

FCS 

Frame Check Sequence (Check sum at the frame end for error detection) 

GPIO 

General Purpose Input/Output  

hea  

File extension of the binary files with the capture information content 
(default.hea) created by the Hilscher netANALYZER software 

NANL-C500-RE 

Analyzer Card NANL-C500-RE 

NANL-C500-RE 

Analyzer Device NANL-B500-RE 

netANALYZER 

netANALYZER software netANALYZER (Windows® Application) 

.NET Framework Version 2.0  

Microsoft .NET Framework Version 2.0  
http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-
4B0D-8EDD-AAB15C5E04F5&displaylang=de 

SFD 

Start-of-Frame-Delimiter: Bits subsequent to the preamble at the start of an 
Ethernet telegram. 

PHY 

Physical Interface 

TAP 

Test Access Point 

http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=de
http://www.microsoft.com/downloads/details.aspx?familyid=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=de
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Wireshark  

„Network Monitoring Program Wireshark“  

http://www.wireshark.org 

WinPcap  

„The Library WinPcap“  

http://www.winpcap.org/ 

 

 

 

http://www.wireshark.org/
http://www.winpcap.org/
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